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About This Manual

NeXT Applications describes in detail how to work with the principal user applications that

come with your
NeXT computer the WriteNow word processor the applications that

search digital libraries and the Mail application You can refer to this manual only when

you want to look something up or you can read through it from start to finish

Before using this manual you should already be familiarwith how to use your NeXT

computer in general as described in the NeXT Users Reference manual Many of the terms

and concepts discussed here were introduced in that manual

Not every NeXT application is described in this manual Utility applications used to

customize and manage the day-to-day use of your computer for example to cancel print

request or change your password are described in Users Reference In addition
TM

applications related to programming on the computer for example Interface Builder are

described in the NeXT Developers Library and system administration applications are

documented in the Network and System Administration manual

Some
parts

of this manual refer to the extended release of the software if your computer

has NeXT disk drive larger than 300 megabytes installed in it youve got the extended

release You can find out the size of the
comuters disk drive or drives by choosing the Info

Panel command in the Workspace Manager

How the Manual is Organized

This manual is divided into several parts

Part describes WriteNow fast and powerful word processor that lets you enter edit

and format text You can enter graphics created outside WriteNow set up

multiple-column documents check the spelling of words in your documents and

perform many other operations

Part describes three applications for accessing information in digital libraries The

NeXT Digital Library includes dictionary and thesaurus digital libraries are also

available from other companies

Part describes Mail multimedia electronic mail application that lets you

communicate freely with other computer users

About This Manual



Two appendices provide supplementary information on WriteNow such as how to

transfer WriteNow documents from an Apple Macintosh to NeXT computer

Finally theres glossary that defines the special terms used in this manual and an index

Special Notation

The following designations are used in this manual

Note An incidental remark that isnt essential to the discussion at hand

Tip Advice that will help you get the most out of the system

Warning cautionary statement that all users should read

About This Manual
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Part

Creating Documents with WriteNow

Pai provides complete description of the WriteNow application fast and poweul
word processor that lets you enter format and edit text In WriteNow what you see is

what you get everything including where the pages break looks the same on the screen

as when printed

While useful for creating short simple documents WriteNow also includes features that

are invaluable for preparing more complex documents There are facilities for defining and

redefining page headers and footers inserting footnotes so theyll always fall on the correct

page dividing the page into multiple columns that you can see while you edit and checking

the spelling of words in document

Text or graphics created outside WriteNow can be pasted into WriteNow document and

graphics can even be embedded in text You can also open plain ASCII files and other types

of documents and convert them to WriteNow documents likewise you can save WriteNow

documents as plain ASCII files or other document types

Part consists of three chapters

Chapter WriteNow Concepts presents concepts that are basic to WriteNow and

important to learn to get
the most out of WriteNow It gives background information

thats needed to understand the commands described in the next chapter

Chapter WriteNow Commands describes WriteNows commands in detail and

includes helpful tips on how to use them

Chapter WriteNow Troubleshooting presents some problems you may encounter

while using WriteNow and suggests an answer for each one

Part Ci-eating Documents with WriteNow



 



Chapter

WriteNow Concepts

This chapter presents basic concepts related to the use of WriteNow including the ruler

page formatting headers footers and footnotes The commands referred to in this chapter

are described in detail in Chapter

Documents

WriteNow document can contain text entered in WriteNow and text or graphics pasted

in from elsewhere Graphics are treated the same way as text you can put them anywhere

you can put text and most operations that apply to text also apply to graphics

You can view WriteNow document in window in three ways

Page view shows the document as it will be printed including page breaks headers

footers footnotes and multiple colunms Only the body of the pagenot headers

footers or footnotescan be edited in this view

Header/footer view shows the headers and footers youve defined in the document You

can edit headers and footers in this view only

Footnote view shows and lets you edit only the footnotes in the document

Using commands in the View menu you can alternate between these three views in the

document window the views arent displayed in different windows

The document window contains the usual close and miniaturize buttons in its title bar

vertical and horizontal scrollers and resize bar In addition to the scroll buttons and 11

that scroll by small increment the height of typical line the vertical scroller contains

and buttons which scroll windowful at time The document window also

contains at the lower right page number field that displays the current page number and

zoom button that allows you to magnify or reduce the view in the window as described

below

Tip The and buttons will scroll page at time if the window displays an entire

page of text which you can ensure by choosing Fit Page with the zoom button

You can have many documents open at the same time in WriteNow Most WriteNow

commands apply to the document in the main window called the current document while

Documents



some apply to the key window which might not contain document The key window may

be the Print panel for example

Magnifying or Reducing the View

The zoom button at the lower right of the document window enables you to magnify the

documents size on the screen as though you were reading it through magnifying glass

Similarly you can reduce the documents size on the screen You use the zoom button by

pressing it to display list of options and then dragging to the option you want number

less than 100 reduces the size while number greater than 100 magnifies it

You can magnify or reduce the view of the document in three ways

Choose number from the list

Choose the Set option and enter number from 25 to 200 in the panel that appears

From then on the number will be shown in numerical order in the list so you can easily

choose it again

Choose the Fit Page option which magnifies or reduces the view so that full page

from the document fits in the document window whatever the windows dimensions

Note If you use high level of magnification the document window might fill up with

white space depending on what was visible in the window when you magnified the view
so you might have to scroll to locate text or graphics

Magnifying or reducing the view doesnt change the dimensions of the document window

or the actual size of anything in the document for example 10-point text will still be 10

points even though it might be magnified to look like 14-point text on the screen

The Page

As shown in the illustration on the next page page of WriteNow document consists of

the header region the body the footnote region the footer region and the right and left

binding margins Every part of the page except the binding margins can be viewed in the

document window in page view The ruler described in detail later in this chapter

excludes the binding margins which are never shown on the screen and are added to the

page only when the document is printed

JO Chapter WriteNow Concepts



______________
header region

body

.1

footnote region

footer region

The header region is at the top of the page Initially it contains four blank lines but you can

define header that overrides this default header More than one header can be defined in

document The header region determines the top margin of the page its the same height on

every page equal to the height of the tallest header in the document Space is added below

any shorter headers to make the region the appropriate height The Show Space command

in the View menu shows thin gray line under the header region

The body of the page contains all text and graphics that arent in headers footers or

footnotes All the typing and editing you do in page view occurs in the body of the page

Text and graphics flow through your document from the body of one page to the body of

the next

The footnote region lies just below the body of the page above the footer region If there

are no footnotes on the page this region is empty it has no height otherwise it contains

short horizontal line with the footnote or footnotes below it

The footer region is similar to the header region only its located at the very bottom of the

page initially it contains four blanks lines As with headers more than one footer can be

defined in document The footer region is the same height on every page equal to the

height of the tallest footer defined in the document Space is added above any shorter

footers to make the region the appropriate height The Show Space command in the View

menu shows thin gray line above the footer region

The Page 11



Note Theres small amount of empty space just below the header region and just above

the footer region WriteNow balances these two amounts to be the same in the printed

document although they might be slightly different on the screen

Finally binding margins may be specified on the left and right sides of the page These

margins initially have no width but they can be used to reserve blank space for binding

printed documents The binding margins are specified with the Page Layout command in

the Page menu and can alternate on odd and even pages

documents pages can be divided into as many as four columns with the Page Layout

command Each column has its own footnote region but theres only one header region

footer region and pair of binding margins per page Binding margins play an important part

in setting up documents with multiple columns see the description of the Page Layout

command in Chapter for more information

Note Youll normally use binding margins only when you want the space for binding to

alternate on odd and even pages or when you create multiple-column document To set

the left and right margins of paragraphs in the body header or footer region or footnote

region of the page youll use the ruler

The Page Number Field

As you scroll through the pages of document the current page number is displayed in

text field at the lower right of the document window the number shown refers to the page

displayed at the top of the document window Even if only line of the page is visible at the

top of the window the current page number refers to that page and not to any other page
in the window The bottom of each page is separated from the top of the next page by

dark gray strip

You can move quickly to given page in the document by editing the page number field to

show the desired page numberfor example by selecting the current number and

retypingand then pressing the Return key When you click in the page number field the

insertion point moves there and any selection in your document is deselected You can also

move to given page by dragging the scroll knob until the desired page number is displayed

in the page number field

The page number is displayed only in page view the page number field is blank in the other

views When youre scaling graphic the page number field and the zoom button goes

away and the dimensions of the graphic are shown in the lower right instead as described

in Scaling Graphics later in this chapter

12 Chapter WriteNow Concepts



Paragraphs

WriteNow document consists of paragraphs appearing in the body header or footer

region or footnote region of the page paragraph consists of text or graphics or both

separated by Return or page break characters

You insert Return character by pressing the Return key what you then type will

appear on the next line Typing one Return starts new paragraph Typing two Returns

in row inserts blank line an empty paragraph There is always Return at the end

of the document and at the end of each header footer or footnote definition

You insert page break character by choosing Insert Page Break from the Page menu
what you then type will appear at the beginning of the next page

As
part

of the word wrap process WriteNow automatically breaks lines between words at

the right margin It breaks lines not only at spaces but also at hyphens soft hyphens

produced with the Insert Soft Hyphen command in the Format menu and em dashes

Alternate-Shift-hyphen It doesnt break lines at nonbreaking spaces Alternate-space en

dashes Alternate-hyphen and characters in the Symbol font family including minus signs

typed on the keypad

Text is combination of printing characters such as letters numbers and punctuation

marks and nonprinting characters such as spaces Returns and page break characters

Printing characters are visible both on the screen and in the printed document Nonprinting

characters appear as blank space in the printed document you can see them on the screen

by choosing Show Space from the View menu

The font in new document is normally 12-point Helvetica Medium but you can change

these properties with the Font command You can also start out with different font

propertiesin fact new documents can be set up any way you like for more information

see the descriptions of the New command and the Preferences command in Chapter

Selecting and Editing

This section summarizes the selecting and editing techniques unique to WriteNow for

details on the standard techniques see the NeXT Users Reference manual

The cursor takes the shape of an I-beam wherever you can select and edit In page view

for example the cursor is an I-beam in the body of the page but an arrow in the header and

footer regions because you cant edit headers and footers in page view you can only edit

them in header/footer view

Paragraphs 13



The same selecting and editing techniques that work with text also work with graphics or

any combination of text and graphics

Positioning the Insertion Point

In addition to positioning the insertion point by clicking with the mouse or pressing the

arrow keys you can also position it by using the arrow keys in combination with other keys

Holding down the Shift key while pressing an arrow key moves the insertion point in

the indicated direction Pressing the left or right arrow key moves the insertion point

one word to the left or right pressing the up or down arrow key moves it up or down

line

Holding down the Control key while pressing an arrow key moves the insertion point

to the corresponding edge of the window If the insertion point is already at that edge

of the window WriteNow scrolls the document one windowful in that direction and

moves the insertion point to the same edge of the new windowful

You cannot position the insertion point in an area where there are no characters such as

beyond the end of line or the end of the document If you try to do this the insertion point

will move to nearby position within the text

Selecting and Editing Text

To select Return or page break character press mouse button when the cursor is to the

left of the character and drag to the right It helps if youve chosen Show Space from the

View menu Returns look like and page break characters look like TJ You cant select

the Return character at the end of the document or at the end of the last header footer or

footnote definition

Any printing or nonprinting character can be selected When you select the last character

on line usually space or Return the empty area between it and the following

character on the next line will also be highlighted

You can extend or shorten selection by Alternate-clicking You can do the same by

holding down Alternate while using the arrow keys For example holding down Alternate

while pressing the left arrow key has the same effect as Alternate-clicking one position to

the left of the insertion point Similarly holding down both Alternate and Shift with the left

arrow key extends the current selection one word to the left

Most editing operations apply only to the current view of the document for example you

cant check the spelling in footnotes unless youre in footnote view When you move copy

or delete text in page view however any headers footers or footnotes defined in the text

are also moved copied or deleted

14 Chapter WriteNow Concepts



Font Properties during Editing

When you insert text by typing at the insertion point you can use the Font menu commands

to set the font properties including typeface and size of the text youre about to type If

you dont set them these properties will be the same as those of the preceding character

with one exception When you type after clicking at the beginning of an existing paragraph

the font properties will be the same as the first character of that paragraph

Text that you paste rather than type at the insertion point will keep its original font

properties unless the text was cut or copied from outside WriteNow in which case it will

assume the same properties as text typed at the insertion point

Note Any text that was entered as part of graphic is stored as graphic image not as

individual characters WriteNow cant change the font properties of this text

When you replace selected text by either typing or pasting the replacement will have the

same font properties as those of the first character of the selected text

Graphics

Graphics in EPS Encapsulated PostScript format or TIFF Tag Image File Format can be

pasted into WriteNow document in the following ways

Through file with .eps or .tiff extension that contains the graphic You can use

the Place Graphic command in the Edit menu which will get the graphic from the file

you specify

Through the pasteboard which contains graphic that you cut or copied from another

WriteNow document from the same document or from an application that writes EPS

or TIFF format to the pasteboard Use the Paste command to paste the graphic on the

pasteboard into your document

Whichever method you use WriteNow creates file containing the graphic and stores that

file in the documents file package As described in Users Reference you dont normally

need to concern yourself with file packages however you may want to look inside them

when working with graphics Inside the file package youll see the file containing the text

of the document which WriteNow names WNDocument.wn and the files that WriteNow

created when you pasted in graphics If the graphic was pasted in from another application

the graphic file is named WNGraphic.xxxxxx.eps where xxxxxx is random six-digit

number Otherwise the graphic file retains its original name with the addition of the

six-digit number

When graphics are hidden with the Hide Graphics command in the View menu the name

of each graphic file without the six-digit number is displayed in gray box that replaces

the graphic If you replace or delete graphic in the document the file containing the
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graphic stays in the file package until the document file is saved compactly see the Save

and Close commands in Chapter

Note You shouldnt rename move or delete the WNDocument.wn file in file package

or you wont be able to open the document You also shouldnt rename move or delete

graphic file directly in the file package or the graphic will disappear from the document and

will be replaced by gray box displaying message that the graphic is missing To restore

the graphic in the document you would have to paste it in again or replace the missing

graphic file If you change the contents of graphic file in the file package the change will

be reflected in the document however if the size of the graphic changed it may not be

displayed properly As described under Scaling Graphics below double-clicking the

graphic and either scaling it or Shift-clicking it will solve this problem

Pasting in Tall Graphics

Graphics can be embedded within paragraph of text graphic doesnt have to be

separate paragraph However when you first paste in tall graphic the graphic is placed in

its own paragraph WriteNow adds Return character before and after the graphic

graphic is considered to be tall when its taller than the header-body separator which is

initially 24 points 1/3 inch see the description of the Page Layout command in the Page

menu for information about the header-body separator and how to change it

If youve chosen Show Space from the View menu line of small arrowheads will appear

above and below the tall graphic as when you use the Page menus Keep on Same Page

command on paragraph The arrowheads appear because WriteNow automatically

applied the Keep on Same Page command to the graphic You cant reverse this automatic

Keep on Same Page with the Allow to Cross Page command but theres no need to do so

as long as you keep the graphic in paragraph by itself If you want to embed tall graphic

within text and also allow the resulting paragraph cross page boundary increase the

header-body separator to the height of the graphic and then use Allow to Cross Page on the

paragraph

Positioning Graphics

After youve pasted graphic into your document you can adjust its position just as you do

text You can use the tabs or margin settings on the ruler to change the horizontal

positioning To center graphic thats in paragraph by itself use the rulers center

alignment button To Æhange graphics vertical position adjust its line spacing in the ruler

or type Return characters You can also make small vertical adjustments to graphic thats

embedded in text by holding down the Alternate key while choosing the Superscript and

Subscript commands from the Font menu
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Scaling Graphics

Double-clicking graphic selects it in special way that lets you change its size The

graphic is enclosed in rectangle and the cursor changes to an arrow when its placed over

the graphic Dragging anywhere within the graphic changes its size and scales the graphic

accordingly Exactly how the graphic is affected depends on whether you hold down

another key while scaling

Key Held Down Effect

None Retains original proportions during scaling

Alternate key Scales to any proportions

Shift key Returns to original size when graphic is clicked

During scaling the size of the graphic is shown at the lower right of the window

temporarily replacing the page number field and zoom button The size shown is

percentage of the size of the original graphic For example

x8O.@ y80.%

means that the graphic has been scaled down both vertically and horizontally by 20% while

x100.S% yl2S.C%

means that the graphic has been scaled up 20% horizontally

The Ruler

The ruler lets you display and change the format of paragraphs the left and right margins

indentation tab stops alignment and line spacing When youve chosen the Show Ruler

command in the Format menu the ruler is displayed just below the document windows title

bar The rulers scale starts at at the left edge of the page excluding any binding margins

and is initially in inches although you can switch to other units of measurement with the

Page Layout command in the Page menu The illustration below shows what the ruler

looks like when its displayed in new document unless specified otherwise see the

description of the New command in Chapter

text alignment buttons tab wells line spacing controls

14

indentation

marker

left margin marker left tab marker right margin marker

The ruler shows the format of the paragraph that contains the insertion point or the

beginning of the selected text Unless you specifically change the format each new

paragraph that you type will have the same format as the preceding one However when
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you move or copy paragraph including the Return or page break character at the end of

it the paragraph will keep its original format

Note If you move or copy paragraphs from one ruler width to another WriteNow scales

the margin indentation and tab settings adjusting them so that theyre in the same relative

places on the new ruler if tab was originally halfway between the margins for instance

it will be so after the move or copy This happens for example if you move paragraphs

between documents of different page or column widths or if you copy paragraph in

multiple-column document into header or footer

When you first press the mouse button in the ruler to begin making ruler setting

WriteNow selects all the text that will be affected by ruler change except when you click

in the line spacing text field in which case the selection is made after youve changed the

spacing So if you want to reformat paragraph you need only click in the paragraph you

dont have to select the entire paragraph When youre ready to type in the document again

just position the insertion point where you want to enter the text

You can move the rulers margin indentation and tab markers to any spot on the scale

When you move marker in the ruler vertical gray line appears running from the marker

to the bottom of the view This line makes it easier for you to determine the position of the

marker relative to the text

When several paragraphs are selected the ruler displays the format of the first one If you
then change ruler setting only that change will be made to the selected paragraphs For

example if you change the right margin on the ruler the right margin of all the selected

paragraphs will be changed but the left margin and all other aspects of the paragraphs

format will remain the same If the ruler already happens to be set to the change you want

to make because its set that way for the first paragraph of the selection just click the ruler

setting you want and it will be applied to the entire selection

You can copy paragraph formats by using the Copy Ruler and Paste Ruler commands in the

Format menu Paste Ruler completely replaces all previous ruler settings For example to

give several selected paragraphs the same format as the first paragraph in the selection you

can use Copy Ruler to copy the format of the first paragraph and then Paste Ruler to apply

it to the entire selection

Relative Settings Command Ruler Change

If you hold down the Command key while making margin indentation or line spacing

change to several selected paragraphs the change will be relative to the current setting for

each paragraph that is the corresponding setting in each paragraph will be changed by an

equal amount The word Relative appears in the ruler when you position the cursor in it

and then hold down the Command key Relative ruler change is useful for example if

you want to adjust the left margins in an outline which typically has several different left

margins by moving all of them half an inch to the right
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Identical Settings Shift Ruler Change

If you hold down the Shift key while making ruler change to several selected paragraphs

the change will be made only to paragraphs that have the exact same settings as all those of

the first selected paragraph The word Identical appears in the ruler when you position

the cursor in it and then hold down the Shift key For example if all the quotations in

document have the same paragraph format and the format is unique to quotations you can

change the left margin for all quotations as follows Select all the text from the first

quotation to the last and hold down Shift while changing the left margin

Tip To take full advantage of this feature give unique formats to the different components

of your document for example headings subheadings and paragraphs in the body of the

page You can ensure uniqueness by placing tab marker in unique position outside the

left or right margin the marker wont affect the format but will associate the ruler with

particular type of component

Paragraph Margins

To set the left or right margin of paragraph drag the corresponding margin marker to the

desired position on the ruler As you drag the left margin marker the indentation marker

moves along with it to keep the same position relative to the left margin however dragging

the indentation marker doesnt cause the left margin marker to move

Indentation

To indent the first line of paragraph so that it begins to the left or right of the left margin

just drag the indentation marker to the desired position

Initially the indentation marker is directly over the left margin marker This aligns all lines

of the paragraph with the left margin

Drag the indentation marker to the right of the left margin marker to get regular

indentation like the indentation of this text

Drag the indentation marker to the left of the left margin marker to get hanging indent like the

one shown here

When you change the left margin of an indented paragraph you dont have to adjust the

indentation WriteNow will automatically adjust it for you moving the indentation marker
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as you move the margin marker Keep this in mind when youre adjusting hanging indent

The only way to change how far the indent falls to the left of the left margin is to drag the

indentation marker away from the left margin marker and not vice versa

In the first line of paragraph that has hanging indent WriteNow treats the left margin

marker like tab stop

For example in bulleted item like this you would press Tab between the bullet

character produced with Alternate-7 and the first word of the item

Tabs

Using tab markers on the ruler you can set any of four kinds of tab stops left center

right and decimal When you need tab marker just drag one from the appropriate tab

well on the ruler and place it at the desired position on the scale each tab well is marked

with the type of tab it contains To remove tab marker drag it to the upper half of the ruler

You can reposition an existing tab stop by simply dragging the marker to new position on

the scale

Pressing the Tab key in paragraph inserts Tab character into the document and moves

the insertion point to the next tab stop The text or graphic following the Tab is aligned with

the tab stop with the type of alignment depending on the type of tab for example left tab

aligns text or graphic on the left decimal tab aligns column of numbers along their

decimal points numbers without decimal points are lined up as though decimal point

were present

Using right tabs and the Insert Soft Hyphen command in the Format menu you can line up

any character with the tab stop Just insert soft hyphen immediately after the character you

want to line up In the example below Tab was typed at the beginning of each line and

soft hyphen was inserted immediately after each symbol aligning those symbols with

the right tab stop The soft hyphen is marker that can be seen on the screen with the Show

Markers command in the View menu its normally used to insert hyphen thats visible

only when word is split between two lines

pamela@brown

edouard@cmu

stan@columbia

If when inserting Tab character you type another character before releasing the Tab key

that character will fill up the space to the tab stop WriteNow will display the fill character

at evenly spaced intervals equal to the width of the widest character in the font The fill

characters will also be lined up on subsequent lines enabling you to create evenly spaced

and aligned leaders as in the following example

Introduction page

Chapter The Beginning page
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You can select and edit Tab characters just as you do any other characters To see Tab

characters on the screen choose Show Space from the View menu Even with fill characters

superimposed on it Tab character is still treated as single character

Tabs are recommended for use only in lines that end with Return rather than lines that wrap

across the right margin and in text thats justified or left-aligned Furthermore its always

best to use the Return key rather than the Tab key to move to the next line even though Tab

will advance to the next line in the following situations When there are no more tab stops

to the right of the insertion point Tab will move to the first tab stop on the next line and

when there are no tab stops at all in paragraph Tab will move to the left margin on the

next line

I4E1

Alignment

The alignment buttons let you specify how you want the text to be aligned in relation to the

left and right margins

Click this to align the text with the left margin ragged right Most of the text in this

manual is aligned this way

Click this to justify the text

Justifying text will adjust the space within all lines of paragraph except the last so

that theyre aligned with both the left and right margins the paragraph ends up looking

something like this Most newspapers and books justify text Justifying wont affect the

width of nonbreaking spaces Also if there are Tab characters within the justified text

WriteNow will observe the tab stops as usual and will justify text between the last tab

stop on the line and the right margin

Click this to center the text between the left and right margins

This Is Most Useful For Titles

And Headings

Click this to align the text with the right margin ragged left

This is the most unusual alignment

possibly useful for

poetry
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In paragraphs with center or right alignment Tab characters dont perform their usual

function instead theyre treated like spaces

-Th-

Line Spacing

This part of the ruler lets you control the line spacing which is the amount of spacing

between lines in paragraph It measures the distance in points from the top of one line to

the top of the next line You can change the line spacing as follows

Select the line spacing number enter new number and
press

Return When you click in

the line spacing field the insertion point moves there and any selection in your document

is cleselected After youve changed the line spacing WriteNow selects the affected

paragraphs

The button on the left decreases the line spacing the button on the right increases it Click

to change the line spacing by one point

Fltblj

Click this to change Fixed to Flexible or vice versa

When the line spacing is Flexible the actual spacing between some lines within

paragraph may be larger than the value set in the ruler If you insert text or graphic

thats taller than the line spacing for the paragraph WriteNow will increase the spacing

as necessary around the line containing the text or graphic The spacing around line

will also increase to accommodate superscript or subscript that extends outside the

normal line-spacing boundaries

Fixed line spacing keeps the spacing fixed at the value set in the ruler for all lines

regardless of their contents When the line spacing is very small text in successive lines

can overlap

The line spacing is initially 14 points and Flexible For fonts smaller than 14 points you

may want to decrease the line spacing to fit more lines on the page You can set the line

spacing to any number from Ito 127 points when the line spacing is Flexible however

theres lower limit at which WriteNow will stop compressing the lines to avoid overlap

If in any paragraph that crosses page boundary the line spacing exceeds the header-body

separator initially 24 points youll probably want to use the Page Layout command in the

Page menu to increase the header-body separator see the description of Page Layout in

Chapter for details
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Headers and Footers

header appears at the top of every page in the header region new document has

default header that consists of four blank lines each 12-point Helvetica Medium with

14-point line spacing unless you specify otherwise see the description of the New
command in Chapter You cannot edit the default header but you can override it by

defining one or more headers of your own header must be at least one line high but no

more than one-fourth the height of the page It may contain graphics and text including the

page number time and date which you can insert automatically with commands in the

Format menu Although you can define several different headers in single document the

header region will always be the same height on every page equal to the height of the tallest

header

The same is true for footers which appear at the bottom of the page in the footer region As

with the default header you can override the blank four-line default footer by defining one

or more footers of your own

To define new header or footer choose the Insert Header or Insert Footer command from

the Page menu This command changes the view from page view to header/footer view and

places the insertion point in four-line blank header or footer definition which you can then

edit See Working in Header/Footer View below for more information To return to page
view from header/footer view choose View Page from the View menu

WriteNow places marker in page view wherever youve inserted header or footer for

header and for footer You can see this marker with the Show Markers command in

the View menu Like all markers it flows with the text as would an inserted character You

can select the marker by dragging across it and then use the Cut Copy or Paste command

to manipulate the header or footer it represents See Operations on Headers and Footers

below for more information

The header or footer definition is tied to the location indicated by the marker as the location

of the marker moves the page on which the header or footer first appears may change The

following rules determine which header or footer appears on particular page

The first header defined on page appears at the top of that page and the last footer

defined on page appears at the bottom

If no header or footer is defined on page the last one defined is displayed

If no header or footer is defined on the first page the default header or footer is used

until one is defined

For example suppose that only two footers are defined in document on pages and

The footer defined on page will appear on pages and the one defined on page will

appear from page to the last page and the default footer will appear on page that is the

footer region on page will be blank and the same height as the footer defined on page

or page whichever is taller
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Tip If you want the same header or footer on every page of document position the

insertion point at the beginning of the document before the first character and choose

Insert Header or Insert Footer If you dont insert any other headers or footers the one you

insert at the beginning will apply to all pages

Working in Header/Footer View

In header/footer view WriteNow displays the definitions of all headers and footers defined

in the document in the order of their occurrence Just below each header definition and

above each footer definition there are two check boxes described below and an icon that

looks like header or footer marker but its not markerit serves only to distinguish

headers from footers in this view dark gray strip appears between definitions in

header/footer view and between the last definition and the bottom of the document window

Header and footer definitions can be edited in the same way as text in the body of page

You can change the height of the header or footer by adding or deleting lines remember

however that the height of the header or footer region on the page will always equal the

height of the tallest header or footer in the document You can select text continuously from

one definition to the next so its easy to change several definitions at once As with

paragraphs in the body of the page you use the ruler to display and change the formats of

headers and footers Unless you explicitly change the format of new header or footer it

will have the same format as the last paragraph of the preceding header or footer

Tip If you want to give header or footer the same ruler settings as the body of

document first copy the desired format in page view with the Copy Ruler command then

switch to header/footer view and use the Paste Ruler command to format the header or

footer

The Even and Odd check boxes indicate which pages the header or footer will appear on
even-numbered pages odd-numbered pages or both Initially both boxes are marked

clicking check box will change it from marked to unmarked or vice versa This feature is

useful in preparing pages that will be laid out facing each other as in book or

photocopied as two-sided copies

Operations on Headers and Footers

In general when working with headers and footers in document you should choose the

Show Markers command from the View menu This will enable you to see exactly where

the headers and footers are defined

The table below summarizes various operations that you might want to perform on headers

and footers while working on document in page view Details follow
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Note Operations on footnotes work in exactly the same way as operations on headers and

footers

Operation What to Do

Edit Select or click before marker and choose View Headers/Footers

from the View menu or double-click in header or footer region

Move Select marker and Cut then Paste marker where desired

Copy Select marker and Copy then Paste marker where desired

Delete Backspace over marker with Delete key or select marker and then

Delete

Locate marker Double-click in the header or footer region whose marker you
want to find choose View Page from the View menu and then

choose Jump to Selection from the Find menu

To change previously inserted header or footer you can return to header/footer view by

choosing View Headers/Footers from the View menu This command places you in the

definition of the header or footer that appears directly after the insertion point or current

selection To go directly to the definition you want to edit you can either select the marker

or click just before it in page view and then choose View Headers/Footers or you can

double-click the header or footer at the top or bottom of the page in page view You can also

simply look for the definition once youre in header/footer view

You cant change theThefault header or footer you can only override it by inserting header

or footer of your own The definition of the default header or footer isnt even shown in

header/footer view If you double-click default header or footer in page view WriteNow

will ask whether you want to insert header or footer at the beginning of the document if

you click OK it will insert blank header or footer that you can edit

When marker is selected the Cut Copy and Paste commands apply to the header or footer

that the marker represents When you cut copy or paste text that has header or footer

defined in it the operation also applies to the header or footer regardless of whether

markers are shown

To delete header or footer that you dont plan to paste elsewhere and so dont need to

place on the pasteboard just backspace over the marker with the Delete key or select the

marker and choose Delete from the Edit menu When you backspace over text that has

header or footer defined in it or replace the text by typing over it the operation also applies

to the header or footer If markers arent being shown WriteNow displays message

informing you that it will delete the header or footer this makes it less likely that youll

accidentally delete header or footer when markers arent shown

Note You cant delete the default header or footer If you delete all your headers or footers

your document will use the default again

Headers and Footers 25



If you see header or footer at the top or bottom of page but are having trouble locating

its marker do the following Double-click the header or footer to go to its definition in

header/footerview choose View Page from the View menu and then choose Jump to

Selection from the Find menu The View Page command will return to the text that was

displayed when you left page view but will place the insertion point just after the marker

for the header or footer you double-clicked Jump to Selection will display the new position

of the insertion point and thus the location of the marker

Tip If you want to check the locations of all the header and footer markers in the

document click at the beginning of the document and then choose these commands to go
to the next marker View Headers/Footers View Page and Jump to Selection

Footnotes

You can create footnotes of any length in WriteNow document Theyll appear in the

footnote region just below the body of the page below the column if the page is divided

into columns Footnotes can contain graphics and text including the page number time

and date which can be inserted automatically with commands in the Page menu

Footnotes are created edited and otherwise manipulated in much the same way as headers

and footers Read the discussion of headers and footers above then see the paragraphs

below for some information thats specific to footnotes

Unless you specify otherwise with the Page Layout command in the Page menu WriteNow

will number footnotes automatically starting from in the order of their occurrence in the

document Page Layout lets you override automatic numbering and specify starting

number other than

To define footnote click in the body of the page where you want the footnote number or

symbol to be located and choose the Insert Footnote command from the Page menu This

command changes your view from page view to footnote view and places the insertion point

in an empty footnote definition you can then type the footnote The text of the footnote will

be 10-point Helvetica Medium unless you change these properties with the commands in

the Font menu or unless you changed them as described under the New command and

Preferences command in Chapter

In footnote view every footnote definition begins with superscripted footnote number

marker thats displayed while markers are being shown with the Show Markers

command in the View menu When markers are hidden or the document is printed the

footnote number appears in smaller font size in place of the footnote number marker

unless youve chosen not to have automatic numbering in which case nothing appears in

place of the footnote number marker

To return to page view from footnote view choose View Page from the View menu When

markers are being shown superscripted footnote marker appears in page view where

you inserted the footnote When markers are hidden or the document is printed the footnote

number appears in place of the footnote marker unless youve chosen not to have automatic
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numbering in which case nothing appears in place of the footnote marker you move
copy or delete the footnote marker or footnote number the operation applies to the entire

footnote just as when you insert new footnote the remaining footnotes are renumbered

automatically to retain their sequential ordering

If theres enough room below the line in which the footnote was inserted the entire footnote

appears in the footnote region at the bottom of that page or column otherwise any extra

footnote text spills over into the footnote region on the next page or column
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Chapter

WriteNow Commands

This chapter describes the menu commands in WriteNow in the order of their appearance

in the menus You should already be familiarwith the basic WriteNow concepts discussed

in the previous chapter as well as with the general system information provided in the NeXT
Users Reference manual

The Main Menu

f1T1 iu1r

Info

Dociimnt

Find-

.Frmat

Pag
Font

VieW

Liridow 1-

Print..

Services

Hide-

Quit

WriteNows main menu contains the standard Windows Print Services Hide and Quit

commands as described in Users Reference The menus opened by the other commands

are described below followed by section on the Document menus Merge command

The Info Menu

lnfPanI

.Preferenes..

In addition to the standard Info Panel command the Info menu contains Preferences

command
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Preferences

The Preferences command opens panel that lets you specify your personal preferences for

WriteNow documents

Note tq n.trt9tt tel icang to et
VVVV

--
VV.V

VV Deitnt --V

Hlvetic 1.Opt VV VV
SetForltl

Diction rr t1rI /riti IVIOV VIV .tIIIfl

creatLIntertoeumntthIaurich Vj VVtH

jVteI selecting the preferences you want click Set If you change your mind before clicking

Set click Revert to see what the settings were when you opened the panel or last clicked

Set

VV VcfaultFt --

Helvetica 12.0 pt
VV

Set Font

This preterence specifies the font in new documents which is normally 12-point Helvetica

Medium The field on the left displays the current setting of this font To change it click

the Set Font button this brings up the standard Font panel where you can then set the new

font Note that you even though you click Set button in the Font panel you still need to

click Set in the Preferences panel to set the preference If you also have Stationery

document as described under the New command below the font you set with Preferences

will still apply except where you specifically set particular font in the Stationery

document

fJictio8x/ re //tlteNI.VFVIlI.VNDICti11fla.I.j.rIdIIt

This field specifies \VriteNows default dictionarythe spelling dictionary it uses unless

you specify different one when you use the Spelling command Initially the default

dictionary is WNDictionary.wndict in WriteNows file package You cant customize that

dictionary because its read-only file but you can change the default dictionary to be

your own copy which you can then customize Simply enter pathname for the default

dictionary in this field

If the file doesnt already exist WriteNow asks you to confirm that you want your own

custom dictionary by that name and then creates the file by copying

WNDictionary.wndict from its file package This copy becomes the new default

dictionary
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If the file already exists it simply becomes the new default dictionary

dpteiçj
WriteNow normally opens an untitled document window when you start up the application

If you would rather not have WriteNow automatically open an untitled document remove

the check from this box

The Document Menu

Open

The Open command opens an existing document It presents the standard Open panel for

specifying which document to open as described in Users Reference The Open panel lists

the names of all files that WriteNow can open

WriteNow document files whose names have .wn extension You can open

WriteNow document files transferred from Macintosh although some features in the

transferred documents wont be retained for details see Appendix Document

Conversion in WriteNow

RTF Rich Text Format files whose names have .rtf extension An RTF file

serves as an intermediate step in the process of converting from one document type to

another For details about opening an RTF file in WriteNow see Appendix

Plain ASCII filesfiles listed in the Open panel that have neither of the above

extensions Plain ASCII files contain only text without formatting fonts graphics

headers footers and so on These files are converted to WriteNow when theyre

opened see the following section for more information

When you open WriteNow document it will come up in exactly the state it was in when

you last saved it For example the ruler will be showing if it was showing when the file
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was saved the insertion point will be in the same place and the document window will

come up in its previous size

When WriteNow document file is opened WriteNow may reformat it under certain

conditions such as if the fonts in the file system changed if the file system doesnt contain

font thats used in the document another font will be substituted or if the document file

was created in different version of WriteNow for example in WriteNow for the

Macintosh Under these conditions WriteNow displays notice saying that its checking

the format of the document to prevent this notice from appearing each time you open the

document be sure to save the document after opening it the first time

Opening Plain ASCII Files

When you open plain ASCII file within WriteNow the following panel appears

onvert

conveig textfile Replace single Return

characters with spaces

cariceti No

If the file was created in an application that performs word wrap such as the Edit

application click No If the file was created in an application that doesnt perform word

wrap and thus has Return character at the end of every line click Yes WriteNow will

replace the individual Return characters with spaces and perform word wrap instead Two

or more consecutive Return characters will be left alone the first one ends paragraph and

the rest result in blank lines

If you clicked Yes when you really should have clicked No you can correct the error by

immediately closing the document window without saving the file and reopening the file

in the correct way

Remember that text can also be moved between WriteNow and other applications by

cutting or copying the text in one application switching to the other application and pasting

in the text In text pasted in from outside WriteNow Return characters are not replaced by

spaces

Note If you open plain ASCii file from the Workspace Manager rather than from within

WriteNow the file will come up in the Edit application
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Opening Shared WriteNow Document Files

To avoid the conflict of two people changing the same file at the same time or one person

reading file while another person is changing it WriteNow puts file lock in

document file when you open it indicating that the file is in use Then when someone else

attempts to open the file WriteNow warns that person that the file is being used and offers

certain options described below These warnings dont appear for files that are read-only

for everyone since file locks arent created for them

When you try to open document file that you have permission to write in but someone else

has open panel will give you the user name of the person using the file and the time and

date the file was last modified The panel contains three buttons Cancel Open Anyway and

Open Copy

If you would rather wait until the document file is no longer being usedfor example

you want to change the original rather than work in copyclick Cancel and
try to

open the file later

If you click Open Anyway another panel will appear warning you that the document

file may be destroyed and that your WriteNow work session may end unexpectedly if

you and the documents other user change the document at the same time You should

click this panels Open Anyway button under two conditions only Youre absolutely

certain that the document tile was open when WriteNow session ended abnormally

as result of power failure for example in which case WriteNow incorrectly

perceives the file as still being open or youre absolutely certain that the document file

was copied in the Workspace Manager while it was being used in which case it still

contains file lock

If you click Open Copy WriteNow will open copy of the document file as an untitled

document which you can read or change as you wish but your changes wont be

reflected in the original document

If you try to open document file that you dont have permission to write in but other people

do panel will warn you that WriteNow cant prevent someone else from also opening the

file and then changing it You can click this panels Open Copy button to open copy of the

document file as an untitled document

New

The New command creates new untitled document and opens it in window The

windows title bar displays

UNTITLED-i or and so on depending on the number of untitled documents

youve opened
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The pathname of the folder in which the document will be stored when you save it with

the Save or Save As command unless you specify different folder

When new document window is opened the insertion point appears at the top of the

window at the beginning of the body of the page The header region isnt displayed but its

there directly above the body Dragging the scroll knob to the top of the vertical scroller

or clicking at the top of the scroller puts the beginning of the header region at the top of

the document window You can see the header region better by choosing the Show Space

command from the View menu

The new document is initially set up in standard way with for example font of 12-point

Helvetica Medium and standard initial ruler settings as illustrated under The Ruler in

Chapter Think of the document as blank piece of stationery that youre about to write

on in this standard format If you would like to start out with different format however

you can do so as described in the following section See also the description of the

Preferences command in the Info menu

Changing the Initial Document Format

You can create different initial format for your new documents by creating document

with the desired format naming it Stationery.wn and putting it in your home folder You

might for example want to start out all your documents with different font or different

margins with markers being shown or with nonstandard page layout Once youve

created the Stationery document all new untitled documents will start out with the same

format and content if any as that document

To override the Stationery document so that you can open standard new document hold

down the Alternate key while choosing the New command To make all your new

documents standard again just delete or rename Stationery.wn or move it to another

folder

Save and Save As

These are the standard Save and Save As commands for saving the current document on

the disk as described in Users Reference They save not only your changes to the

documents text and graphics but also the documents exact state on the screen including

whether the ruler is showing where the insertion point or selection is and so on

When you save an untitled document or use the Save As command WriteNow presents

panel for naming the document file and putting it in folder In both cases youre left in the

newly named document Save As also puts away the original document so any changes

made to it and not previously saved are stored only with the newly named document
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This is the standard Save panel except that it also lists choice of file types for your saved

document Normally WriteNow is selected for saving WriteNow document in the

usual way and WriteNow adds .wn extension to the file name you enter unless YOU

type the extension yourself

You can select another type of document in the bottom part of the Save panel and have your

WriteNow text converted to that type just as you can convert other types of files to

WriteNow with the Open command Text and Text with line breaks are for saving the

WriteNow document to plain ASCII file which may be required if you want to work with

the text in another application In plain ASCII files page break characters are replaced by

Return characters and Tab with fill character is replaced by an ordinary unfilled Tab

character all graphics font properties and formatting including headers footers and

footnotes are removed Text does 110 further conversion Text with line breaks

additionally inserts Return charactei at the end of every line that was broken due to word

wrap

RTF is for saving the WriteNow document to an RTF file which may be required if you

want to convert fiVOm one document type to another and retain the documents font and

formatting For details about saving WriteNow document as an RTF file see Appendix

Conserving Disk Space

if you hold down tile Alternate key while choosing Save or Save As WriteNow will save

the document as compactly as possible when it closes the document When WriteNow saves
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document compactly it reclaims unused space that sometimes results from editing and

deletes the following

The backup copy of the document that you could otherwise revert to with the Revert to

Backup command If you dont save compactly you can undo the Save or Save As

command with Revert to Backup

Any graphic files in the documents file package that contain graphics youve deleted

from the document

Saving WriteNow document youve edited doesnt require free space on the disk the size

of the document only the space necessary to save your changes is required Rather than let

you create document thats too large to save on your disk WriteNow warns you as soon

as you pci-form an operation whose results cant be saved and undoes that operation You

can then save your previous changes and if you like free up space on your disk and retry

the operation that failed

Revert to Saved and Revert to Backup

As illustrated below the Revert to Saved command returns you to an earlier version of your

documentto the state the document was in the last time you saved it Similarly the Revert

to Backup command lets you return to still earlier version of your documentto the state

it was in before the last time you saved it

Revert to Revert to

badp Backup Saved

copy -coj5y cren

Note Two copies of your document are always kept in your file on the disk This doesnt

require twice the space because text thats common to both versions is shared between the

copies

You can choose Revert to Saved whenever youve edited the current document and havent

yet saved your changes If you choose this command by mistake you can immediately use

the Undo command from the Edit menu to go back to where you were

Whenever youve just opened or saved document or have chosen Revert to Saved the

Revert to Backup command is available You can undo Revert to Backup with the Undo

command

When youve edited document but havent yet saved your changes the Revert to Backup

command is dimmed you would first have to Revert to Saved to get to the last-saved state

of the document If you then chose Revert to Backup the unsaved changes would be lost

Revert to Backup is also dimmed when theres no backup copy to revert to as when youve
saved document compactly to conserve space
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Once WriteNow has created file package as result of graphics being pasted into

document that document will always be in file package even if you revert to version

containing no graphics Whenever you revert to an earlier version of document after

having added graphics the corresponding graphic files wont be deleted from the file

package until the file is saved compactly

Merge

The Merge command lets you merge information from one document into another and is

useful for producing form letters Its described in its own section at the end of this chapter

Close

The Close command closes the current document removing the main window from the

workspace If youve changed the document in any way since last saving it WriteNow

presents panel that gives you the opportunity to save your changes

Click Save to save the document in the normal way

Click Save/Compact if you need to conserve space on the disk WriteNow will save the

document as compactly as possible reclaiming unused space that sometimes results from

editing Save/Compact also deletes the documents backup copy and any graphic files

containing deleted graphics for more information see the description of the Save and Save

As commands

The unused space that results from editing will never exceed 25% of the documents size

not including the documents graphics and backup copy Even if you havent made

changes since last saving or if you close without clicking Save/Compact WriteNow will

still reclaim the unused space that results from editing if the unused space exceeds the 25%

limit

Occasionally youll see this panel when you havent made any changes yourself but have

performed operations that caused WriteNow to make internal changes to the document For

example when you check spelling WriteNow marks passages of text that have been

checked so theyre not checked again until you modify them this qualifies as change

You can close all open WriteNow documents at once by holding down the Alternate key

while closing any document with either the Close command or the close button
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The Edit Menu

I-r

Cut Copy Paste and Delete

These are the standard editing commands as described in Users Reference They work

with both text and graphics although they dont work within graphics for details about

graphics in WriteNow see Graphics in Chapter of this manual

Undo or Redo

The Undo command reverses the effect of the last action that changed text in your

document whether typing ruler change or command Commands that can be undone

include not only text editing commands like Cut and Paste but also the documentlevel

commands Revert to Saved and Revert to Backup

The Undo command in the menu changes to indicate what youre about to undofor

example Undo Typing or Undo Ruler Change Immediately after you choose Undo it

changes to Redo which will undo the Undo command

After you choose command that cant be undone such as New or Open Undo changes

to Cant Undo and is dimmed in the menu

Place Graphic

The Place Graphic command gets graphic from specified file and inserts it at the

insertion point or replaces the current selection with it The command brings up the

standard Open panel where you specify the file containing the graphic For more

information about working with graphics see Graphics in Chapter

38 Chapter WriieNow Commands



Change Case

The Change Case command lets you change the selected text in any of the three ways listed

below in the panel it displays click the option that you want

Option Changes Example

Changes this To this

Capitalize Words First letter of all spin the bottle Spin The Bottle

words to capitals sending an SOS Sending An SOS

Lowercase All letters to Panel panel

lowercase DEATH-DEFYING death-defying

Uppercase All letters to Quick Start QUICK START

uppercase death-defying DEATH-DEFYING

capitals

Count

If no text is selected in the current document the Count command reports the total number

of characters words and paragraphs in the current view of the document In page view this

command applies to the entire document excluding any headers footers or footnotes in

header/footer or footnote view it applies only to the text in that view If text is selected the

command reports
the same counts for the selected text

The Count command considers the hyphen character to be one of the punctuation marks

that separate words When counting paragraphs it does not count empty paragraphs

panel shows the numbers as theyre being calculated For very large amounts of text the

command may take while you can interrupt it by clicking the panels Stop button

Spelling

The Spelling command presents panel that lets you check the spelling of words in the

current view of your document choose from possible corrections and create customized

copies of WriteNows spelling dictionary

WriteNows spelling checker considers the hyphen character to be one of the

punctuation marks that separate words however it ignores all markers including page

number time and date markers WriteNow will not look up words that are all numeric such

as 10 but it will look up combinations of numeric and alphabetic characters so you can

add words like 10th to the dictionary if you like
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Note Sections of text that have been checked for spelling errors are marked internally as

having been checked If you check the spelling of that text again it wont actually be

checked unless youve edited the text since the last time you checked it or unless youre

using different spelling dictionary

The Spelling Dictionary

WriteNow supplies its own 100000-word spelling dictionary WNDictionary.wndict and

an empty dictionary WNEmptyDictionary.wndict both stored in WriteNows file

package in /NextApps

Initially WriteNows default dictionarythe dictionary it uses unless you specify

different one with the Load button in the Spelling panelis WNDictionary.wndict in its

file package Although you cant change that dictionary you can customize your own copy

of it WriteNow provides these convenient ways of getting copy of

WNDictionary.wndict and making the copy the new default dictionary

The first time you use the Spelling panel to add or remove words from the dictionary

WriteNow asks you to confirm that you want your own custom dictionary and then puts

copy of WNDictionary.wndict in your home folder also naming it

WNDictionary.wndict

You can specify different default dictionary with the Preferences command in the Info

menu If the dictionary you specify doesnt exist WriteNow similarly asks you for

confirmation and then creates that dictionary by copying WNDictionary.wndict

You can have as many custom dictionaries as you like Use the Workspace Manager to make

copies of existing dictionaries including the empty dictionary to create one from scratch

Youll do all customization with the Learn and Forget buttons in the Spelling panel The

Load button in the Spelling panel lets you specify the name of dictionary you want to use

other than the default dictionary

The Spelling Panel

As convenience WriteNow doesnt bring up the Spelling panel as the key window so that

you can type to correct misspelling without having to click in the document window first
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Find Ne4

To search for the next word not contained in the spelling dictionary click Find Next in the

Spelling panel or choose the Check Spelling command from the Edit menu The search

starts at the word containing the insertion point or at the last word in the current selection

and goes to the end of the document Find Next doesnt distinguish between capital and

lowercase letters or between the single quotation marks and message informs you if

no more misspelled words are found

Remember that the search for misspelled words starts at the insertion point or current

selection If you want to check the entire document from beginning to end youll have to

click at the beginning of it first

Once word not contained in the spelling dictionary has been found click Guess if you

ant \Vi ileNow to displa\ list of possible corrections The corrections will be listed in the

Spelling panel clickin one of them will replace the misspelling with the desired

correction

jqnore

If correctly spelled word is identified as misspelled and you dont want to add it to the

dictionary perhaps its correct in this context but inappropriate elsewhere you can click

Ignore That word will never be caught again in this document it will however be detected

as misspelled in other documents After ignoring the word WriteNow will locate the next

misspelled word in your document Up to 200 words may be ignored in any document if

you ask WriteNow to ignore more than this it will keep track of only the last 200 To start

over again without any words being ignored hold down the Alternate key when you click

Ignore
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If you select more than one word to ignore all the words in the selection will be ignored

even if theyre only partially selected

Fer-et-

The Forget and Learn buttons let you remove or add words from the dictionary youre

currently using The first time you use Forget or Learn when the current dictionary is

WNDictionary.wndict in WriteNows file package read-only file WriteNow asks you

to confirm that you want your own custom dictionary see The Spelling Dictionary above

for more information

If correctly spelled word is identified as misspelled you can acid it to the dictionary by

clicking Learn After adding the word WriteNow will locate the next misspelled word in

your document You can also remove word from the dictionary by selecting it in the

document and clicking Forget

Note Changes you make with Forget and Learn take effect immediately but arent actually

incorporated into the copied dictionary until youve accumulated about 120 of them or until

you quit WriteNow If your WriteNow session ends abnormally you may have to make the

changes again

If you select more than one word to Forget or Learn the operation will apply to all the

words in the selection So you could for example start out with an empty dictionary select

all the text in document and click Learn to get dictionary that consists only of the words

in that document

To use spelling dictionary other than WriteNows default dictionary click Load

WriteNow will present the standard Open panel you can then open the dictionary file you

want to use see The Spelling Dictionary above

The Accuracy of the Spelling Check

The words in WriteNows spelling dictionary were chosen on the basis of the frequency of

their appearance in contemporary English text Plurals of nouns the past tense of verbs and

similar forms of words are separate entries in the dictionary depending on their frequency

some of these forms may not have been included Youll probably find that some of words

used in your document are not in the dictionary you can acid them with Learn

The spelling dictionary is encoded in compact way that saves storage on your disk but has

the following side effects

Approximately one in every 50000 misspelled words will not be detected as

misspelled Assuming an average of ten misspellings per document this means that

misspelling will go undetected in only one out of every 5000 documents
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When WriteNow generates list of possible corrections for misspelling

approximately one in every 300 lists will contain misspelled suggestion

shortcoming common to spelling checkers is that errors in context wont be detected For

example WriteNow wont find anything wrong with the sentence Their is mistake hear

somewhere

Check Spelling

Choosing the Check Spelling command has the same effect as clicking Find Next in the

Spelling panel see the Spelling command above Check Spelling locates and selects the

next word not contained in the dictionary To replace the misspelled word you can just

begin typing

For more options when checking spelling use the Spelling command either after Check

Spelling or instead of Check Spelling

Select All

The Select All command selects all the text in the current view of your document Cutting

copying or pasting the text will include any headers footers or foolnotes that are defined

in it however other editing operations will apply only to the current view For example

you can copy the entire contents of the document by choosing Select All in page view and

then choosing Copy however if you want to change the font of all headers footers or

footnotes you have to Select All and change the font in the corresponding view of the

document

The Find Menu

WriteNows Find menu contains the standard Find menu commands as described in Users

Reference theyre described under the Edit menu where Find is located in many

applications Infonnation specific to WriteNows Find panel is presented here

Find Panel

The Find Panel command brings up the following panel which contains the standard Next

and Previous buttons along with other buttons and check boxes specific to WriteNow
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Specifying the Text

You can enter up to 255 characters in the Find field You can search for any sequence of

characters including spaces Tabs and Returns Note the following

You cant type Tab or Return in the Find field because of their other functions Tab

will move the insertion point to the Replace with field and Return will begin the

search for the text To specify Tab in the text to be found type Alternate-Tab \T or

\t Likewise type Alternate-Return \R or \r to specify Return or page break

character

Using question mark the wild card characteryou can search for any

character or page number time or date marker but no other type of marker For

example rse will find rise rose and ruse but not rouse To explicitly search

for question mark type\

Two characters in row in the Find field represent the character itself So if for

example you want to search for the characters \t rather than Tab type \\t

Specifying the Search Options

The check boxes in the Find panel let you specify options that determine exactly how the

search for the text will proceed

Ehtire Dacument

The scai-ch for the next occurrence starts at the insertion point or end of the current selection

and goes to the end of the document if Entire Document is checked the search then

continues at the beginning of the document and stops back where it started Similarly the

search for the previous occurrence starts at the insertion point or beginning of the current

selection and goes to the beginning of the document if Entire Document is checked the

search continues at the end of the document

Remember that if you want to start searching at the beginning of the document you must

click at the beginning of it first
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If Whole Word is checked WriteNow will find only entire words that match the specified

text otherwise it will find the text anywhere whether an entire word or only part of word

Word here means the same as what you select when you double-click except that the

hyphen character is considered to be one of the punctuation marks that separate words

If Ignore Case is checked WriteNow doesnt distinguish between capital and lowercase

letters during the search and considers each of the following sets of characters to be

identical

Space and nonbreaking space Alternate-space

Double quotation marks

Single quotation marks

If Ignore Case is not checked WriteNow searches only for text that exactly matches the

capital and lowercase characters you specify and distinguishes between the characters

listed above

In the text being searched WriteNow always ignores soft hyphens and header footer

footnote and footnote number markers but not page number time and date markers

Searching

WriteNows Find panel contains the standard Next and Previous buttons with an additional

feature When you bring up the Find panel with the keyboard alternative for the Find Panel

command Commandfpressing Return not only operates the Next button but also closes

the panel This enables you to do quick onetime search and immediately close the panel

all from the keyboard

Click Replace All to replace all occurrences of the specified text with text specified in the

Replace with field or to delete all occurrences if the Replace with field is blank

Note Replace All replaces all occurrences of the text in the document not just those

following the insertion point

RepJae1

Once the text has been found click Replace if you want to replace that occurrence with text

specified in the Replace with field or if the Replace with field is blank and you want

to delete that occurrence
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As shortcut you can click this button to combine the Replace and Next operations

WriteNow will replace or delete the found text and then find the next occurrence

The Format Menu

I.iTTi

at

Show Ruler or Hide Ruler

The Show Ruler command displays the ruler at the top of the current document window

and the Hide Ruler command removes it

Insert Soft Hyphen

The Insert Soft Hyphen command inserts soft hyphen at the insertion point or in place of

the current selection soft hyphen is hyphen thats visible only when word is split

across two lines of text at the point where you inserted the soft hyphen WriteNow

automatically splits words at soft hyphens whenever doing so allows more text to fit on

line If markers are being shown marker appears at the soft-hyphen point When markers

are hidden or when the document is printed nothing appears at the soft-hyphen point if the

line doesnt break there otherwise hyphen appears at that point

Tip The fastest way to insert soft hyphen as you type is to use the keyboard alternative

Command-hyphen

You can remove soft hyphen by selecting and deleting it when markers are visible by

backspacing over it with the Delete key or by deleting the word its embedded in When

you backspace over an invisible soft hyphen the insertion point wont move but the hyphen

will be deleted

.16 Chapter iVriteNon Commands



Indent Left to Tab and Indent Right to Tab

The Indent Left to Tab and Indent Right to Tab commands reformat the paragraph

containing the insertion point or the paragraph or paragraphs containing the current

selection by moving the indentation marker and the left margin marker to the left or right

The indentation marker moves to the next tab stop in that direction and the left margin

marker moves accordingly to keep the same distance as before between it and the

indentation marker

These commands are convenient to use when youre working on an outline with several

levels of indentation just set tab stop at each of the indentation levels and choose Indent

Left to Tab or Indent Right to Tab or type the commands keyboard alternative to move

quickly from one level to another Be sure to include left tab stop at the highest level so

that Indent Left to Tab can return there when youre one level to the right

Insert Page Number

The Insert Page Number command inserts the current page number at the insertion point or

in place of selected text When markers are being shown or in header/footer view you see

marker where you inserted the page number when markers are hidden in page view or

when the document is printed the page number appears

Insert Time and Insert Date

The Insert Time command inserts the time at the insertion point or in place of the current

selection the Insert Date command does the same for the date panel offers two options

T1
Click Fixed Text to insert text showing the current time or date Unlike Updating Marker

below this text wont change unless you edit it yourself

If you click Updating Marker the inserted time or date will be updated continually as

follows On the screen it will reflect when the document was opened in the printed

document it will reflect when printing began When markers are being shown youll see

marker for time for date where you inserted the time or date When markers are

hidden or when the document is printed the time or date appears but it will be treated like

single character You can only select it as unit and it can never be split by line break

For example you can select the entire date and change its font but you cant select and

delete the year from the date or change the font of only part
of it

The Format Meni 47



Note that when you choose Updating Marker the time or date marker is saved with the

document not the time or date also these markers always represent the current time or

date not necessarily when you created the document So if you want document to always

show the date it was created choose Fixed Text instead

Copy Ruler and Paste Ruler

The Copy Ruler command copies the ruler settings of the paragraph containing the insertion

point or the beginning of the current selection so that you can subsequently paste them with

the Paste Ruler command Its as though theres separate pasteboard for the ruler and

Copy Ruler replaces whats already on it just as the Copy command does for text

The Paste Ruler command selects the paragraph containing the insertion point or the current

selection and replaces the paragraphs ruler settings with the last ones you copied with the

Copy Ruler command If the current selection spans more than One paragraph Paste Ruler

selects all the paragraphs it spans and replaces their ruler settings

Tip You can change the ruler settings of only those paragraphs whose rulers match the

first paragraph of selection by using the Shift key when you make the ruler change as

described in Chapter

Neither of these commands requires the ruler to be showing or changes the contents of the

pasteboard

The Page Menu

atuj

Insert Header and Insert Footer

The Insert Header and Insert Footer commands insert new header or footer into your

document and anchor it with marker at the insertion point or in place of the current

selection
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Insert Header changes the view from page view to header/footer view and places the

insertion point on the last line of four-line blank header definition which you can then edit

After you return to page view using the View Page command in the Page menu the header

is displayed where it will appear when printed in the header region at the top of the page
The header region is always the height of the tallest header defined in the document If

markers are being shown marker will be displayed whereyou-inserted the header

when markers are hidden or when the document is printed the marker is invisible

Similarly Insert Footer lets you create footer that will be displayed in the footer region at

the bottom of the page The marker for footer is

The first header defined on page appears at the top of that page and the last footer defined

on page appears at the bottom If no header or footer is defined on page the last one

defined is displayed If no header or footer is defined on the first page the default header or

footer is used until one is defined

Headers or footers you insert override the default header or footer If you delete all your

headers or footers your document will use the default again

Insert Footnote

The Insert Footnote command inserts new footnote in your document and anchors it with

marker at the insertion point or in place of the current selection This command changes

the view from page view to footnote view and places the insertion point in an empty

footnote definition you can then type the footnote Unless youve chosen not to have

automatic numbering by turning it off in the Page Layout panel the footnote definition

will begin with footnote number thats superscripted and in smaller font size The

numbers start at unless youve specified another starting footnote number in the Page

Layout panel If markers are being shown footnote number marker appears in place of

the number

After you return to page view using the View Page command in the Page menu the

footnote is displayed where it will appear when printed in the footnote region below the

body of the page If markers are being shown footnote marker appears where you

inserted the footnote When markers are hidden or when the document is printed the

footnote number appears if youre using automatic numbering or the marker becomes

invisible if not

Insert Page Break

The Insert Page Break command inserts page bieak character at the insertion point or in

place of the current selection The page break character is nonprinting character that

causes WriteNow to start new page Text following this character will begin at the top of

the next page You can select page break character by dragging across it from left to
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right and delete it to remove the forced page break To see page break characters on the

screen choose Show Space from the View menu theyll be displayed as

Keep on Same Page and Allow to Cross Page

The Keep on Same Page command lets you keep all lines of one or more paragraphs on the

same page It selects and keeps together the paragraph containing the insertion point or the

current selection if the selection spans more than one paragraph it selects and keeps

together all the paragraphs containing the selection If all the lines of the selected

paragraphs dont fit on the current page theyre moved to the top of the next page Any page
break characters in the selected paragraphs are replaced by Return characters

Before and after every group of paragraphs that have been kept together the Show Space

command in the View menu shows lines of small arrowheads across the page

The Allow to Cross Page command reverses the effect of the Keep on Same Page command
It lets all lines of one or more paragraphs be separated across page break It doesnt

however restore any page break characters that Keep on Same Page replaced with Return

characters Like Keep on Same Page it applies to the paragraph or paragraphs containing

the insertion point or current selection

WriteNow automatically keeps on the same page any paragraph that contains graphic

taller than the header-body separator which is initially 24 points and can be changed with

the Page Layout command The Allow to Cross Page command wont reverse the effect of

this forced Keep on Same Page

Page Layout

The Page Layout command lets you specify various options that affect the appearance of

your documents pages WriteNow uses variation of the standard Page Layout panel This

section discusses only the issues related to WriteNows Page Layout panel for discussion

of the standard panel see Users Reference

When you choose the Page Layout command the entire document is selected to indicate

that all of it will be affected by the command When done the command restores the

selection to what it was before

If any of the page layout changes affect the width of the ruler WriteNow scales the margin

indentation and tab settings accordingly putting them in the same relative places on the

new ruler As result you can switch to new page layout and then return to the old layout

without losing your original settings For example if you switch from an 1/2inch-wide

page to an 11-inch-wide page tab marker at 1/4 inches on the old ruler moves to the new

halfway mark of 1/2 inches on the new ruler and vice versa if you return to the old ruler
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If change in the page layout reduces the width of the ruler and the new ruler is narrower

than the document window WriteNow makes the document window narrower

Tip Because some page layout changes will change the ruler width and scale the ruler

settings its best to do the page layout first before formatting the paragraphs in the

document

Page Layout

PapPi Size

rietter IJ

Layout

width Height fTT LJrIItJ

Portrait Landscape .-

-__- ----columns -.-
-ci .c-2-c3- .4

Binding Margins

Left Right ji

auto number Starting number

Headei body sPpaitnr Srriart quatP

Starting paqe

cancel _____

The top hail of the panel conlain the standard Page Layout options The Units button sets

the unit for all measurements in VvriteNow including the Width and Height fields Binding

Margins fields and the ruler The Scale field is dimmed in WriteNows Page Layout panel

you can use the document windows zoom button to magnify or reduce the size of the

document on the screen

The Page Layout options that are specific to WriteNow are described in the following

paragraphs

Ciiumns

--ci c2 ca r-4-

This specifics the numberol columns of text on each page See Multiple Columns below

for more information
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ltemdte _J Left Eiilht

The Left and Right fields are for specifying the widths of the left and right binding margins

which reserve blank space for binding printed documents The unit of measurement is the

same as the unit on the ruler You can enter any whole or fractional number such as .5

or 2.33 Since the ruler doesnt include the binding margins WriteNow reduces the width

of the ruler by the widths of the binding margins and scales down the ruler settings

accordingly

The Alternate check box indicates whether the document will have alternating binding

margins for two-sided copies If you check this box the left and right binding margin

widths will be reversed on even-numbered pages

Its best to set the binding margins before formatting the paragraphs in the document so

that youll be working with the final ruler width from the start

Frctnotp

utj riwrjhr tnL1 nunhpr

The check box indicates whether lootnoles \vill he numbered automatically by WriteNow

The text field contains the starting footnote number for the document if footnotes are being

numbered automatically you should change this number if for example youve placed

each chapter or section in separate document but want the footnotes to run consecutively

on shouki iworc this option unless your document contains inc talki than 24 points in

paragraph that may cross page houndar\ he /lethIerh /v .vcpaiil ii should be set

greater than equal to the hciht of the tallest inc in an\ such paragraph If in any

paragraph that may cross pare houndar you increase the line spacing beyond 24 points

oi insert text or graphic taller than 24 points you should probably increase the

headerbody separator accordingly br the lollowing reasons

If paragraph contains graphic taller than the header-body separator WriteNow will

force the paragraph to be kept on the same page However you may want the paragraph

containing the graphic to be able to cross page boundary If you make the graphic

shorter so that its no longer taller than the headerbody separator youll then need to

use the Allow to Cross Page command to enable the paragraph to cross page

boundary
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In rare cases if paragraph contains line taller than the header-body separator but

doesnt contain tall graphic the paragraph will collide with the header region when it

crosses page boundary cutting off part of the first line on that page line might be

taller than the header-body separator because of large font size or the use of

superscripts or subscripts or because you set the line spacing to be greater than the

header-body separator To reduce the possibility of collisions with the header region

dont set the header-body separator smaller than 24

You can set the header-body separator to maximum value of 64

Note The value of the headerbody separator is directly proportional to but is not an exact

measurement of the amount of empty space below the header region Increasing the

header-body separator increases the amount of empty space below the header region and

decreasing the header-body separator decreases this space

Srtttjuot8s

This specifies whether the characters and which you get by pressing the key without

Shift and with Shift respectively will be converted to the characters and as you type

in the document For example rather than

dont know what you mean by smart quotes he said

you would get

dont know what you mean by smart quotes he said

If you didnt set smart quotes you would have to type the correct typographical symbols

yourself as shown in the following table If you set smart quotes however all you have to

do is type and and the symbols will automatically be convei4ed for you

Symbol Without Smart Quotes With Smart Quotes

AlternateI or key on keypad key

Alternate or key key

Alternate Shift
Alternate Shift

With smart quotes set or typed after space nonbreaking space Tab Return

or will be converted to or respectively typed after any other character will be left

alone while typed after any other character will be converted to with one exception
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after becomes

after becomes

Note The smart quotes algorithm was provided by David Dunham of Maitreya Design

When smart quotes is set and you want to override its effect type Command- to get or
Command- to get To get at any time hold down the Alternate key and press the key

Remember smart quotes only affects text typed after its set any and characters typed

before its set will not be converted Similarly deselecting smart quotes will not convert

characters to and

This is the starting page number for the document It may be any number including or

even negative number in case you want the page numbered to begin after the first

physical page of the document

Tip If you want the document to have an unnumbered title page and then begin with page

numbered set the starting page number to On the second physical page which will be

numbered insert header or footer containing the page number inserted with Insert Page

Number in the Format menu If you want two unnumbered pages before page that is the

third physical page should be page set the starting page number to

Multiple Columns

When you specify multiple columns with the Page Layout command WriteNow divides the

body and footnote region of every page into the indicated number of columns all having

equal widths The text in the body of the page flows from one column to the next The ruler

starts at at the left edge of each column the ruler settings are scaled down accordingly

and are shown oniy for the column containing the insertion point or the beginning of the

selected text

As illustrated below the spacing between columns is determined by the left and right

margins of the paragraphs within the columns For simplicity in the illustration the left and

right margins are the same for each column but they can vary by paragraph also each

footnote can have its own left and right margin settings
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header region

Ea
EE

footnote footnote footnote

region region region

footer region

To leave additional space blank at the left and right edges of multiple-column document

without affecting the spacing between columns you have to set the binding margins rather

than the left and right margin settings on the ruler

Notice that only the header region and footer region extend all the way across the page
centered title in the body of the page will be centered only within the column containing the

title specifically between the left and right margins of the paragraph If graphic in the

body of the page is wider than the column its in youll see only what fits in the column

but you can scale the graphic down by double-clicking it and then dragging within it to the

left

When you print multiple-colunm document the columns will be balanced They will all

begin at exactly the same vertical location and all but the last column will end at the same

vertical location On the screen however the columns will not be perfectly balanced

In multiple-column document the header-body separator should be greater
than or equal

to the height of the tallest line in any paragraph that may cross column boundary rather

than page boundary Also the Keep on Same Page and Allow to Cross Page commands

affect whether text is kept in the same column rather than on the same page
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The Font Menu

WriteNows Font menu contains the standard Font menu commands as discussed in Users

Reference Information specific to using WriteNows Font menu is presented here

When using large font sizes remember that collisions with the header region may occur if

paragraph contains text taller than the header-body separator initially 24 points see the

discussion of the header-body separator under Page Layout earlier in this chapter for

more information

Tip If you want small font size in the printed document but would rather work in larger

font size on the screen you can use the zoom button at the lower right of the document

window to magnify the size of the text shown on the screen

Superscript and Subscript

These are the standard Superscript and Subscript commands with an additional feature If

you hold down the Alternate key while choosing Superscript or Subscript the text moves

up or down one pixel you can use this repeatedly to get the exact positioning you want

Changing Identical Font Properties Shift Font Change

If you hold down the Shift key while changing one or more font properties of selection

the change will be made only to selected text that has the same font properties as the first

character of the selection For example if the first character of the selection is 12-point

Helvetica Medium and you increase the size by two points while holding down the Shift

key the change will apply to all 12-point Helvetica Medium text in the selection

Tip The Shift key is used to indicate identical here just as when you make changes in

the ruler to paragraphs with identical settings If you forget which key to use for this feature

position the cursor over the ruler and then press the potential keys until the word Identical

appears in the ruler

Note This feature doesnt apply to superscripting and subscripting nor does the Copy

Font command
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The View Menu

Sho Space

Hide Graph1L

iePage
/leA HedrFooter

JA/Footno1e

Markers or Hide Markers

The Show Markers command displays markers in your document as indicated in the table

below

Marker Stands For

Header

Footer

Footnote

Footnote number

Page number

Time

Date

Soft hyphen

The page number marker is always shown in header/footer view and footnote view

The Hidc Markers command is in effect when you open new document unless youve

overridden it in your Stationery document It does the following

Makes all header and footer markers invisible

Displays all footnote markers and footnote number markers as footnote numbers unless

youve chosen not to have automatic numbering in which case it makes the markers

invisible

Displays all page nwiber time and date markers as page numbers times and dates

respectively except for page number markers in header/footer view

Displays all softhyphen markers as hyphens if appropriate otherwise it makes the

iarker iiwisible
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Regardless of whether markers are being shown markers are always hidden in printed

documents

Note Page number time and date markers are displayed where the text they represent will

begin when the document is printed or when markers are hidden WriteNow calculates the

width of the text so the line breaks you see on the screen will be the same as what youll

get in the printed document

Show Space or Hide Space

The Show Space command lets you see nonprinting characters in the current document as

well as other items of interest that would otherwise be invisible see the table below

Note Nonbreaking space created by typing Alternate-space remains invisible when

Show Space is chosen

Item How Displayed

Space Adotasshownbetweenthese.words

Tab -- ------- variable width

Return

Page break character

Bottom of header region ---across the page
and top of footer region

Paragraphs to keep on across the page above paragraphs

same page across the page below paragraphs

The Hide Space command is in effect when you open new document it makes all of the

above invisible Space is always hidden in printed documents

Although it isnt shown in the menu theres keyboard alternative for the Show Space and

Hide Space commands Command-space

Show Graphics or Hide Graphics

With the Show Graphics and Hide Graphics commands WriteNow lets you temporarily

suppress the display of graphics in your document so that you can work more quickly with

the text If your document contains complicated graphics that are time-consuming to

display you can speed up your work by hiding the graphics
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The Show Graphics command is in effect when you open new document all graphics that

you insert are displayed in the usual way Hide Graphics displays gray box in place of

every graphic the box is the same size as the graphic so line breaks and page breaks arent

affected In addition the name of the corresponding graphic file in the documents file

package is displayed in the box

Regardless of whether graphics are being hidden on the screen they always appear in

printed documents unless the file containing the graphic has been moved or deleted from

the documents file package

View Page

The View Page command displays the current document as it will appear when printed In

page view text in the body of the page can be edited Headers footers and footnotes cannot

be edited in this view although theyre displayed as they will appear when printed

You use the View Page command to return to page view from header/footer or footnote

view It returns you to the same part of the document as when you left page view but places

the insertion point just after the marker for the header footer or footnote that last contained

the insertion point or selection in the view you came from

View Headers/Footers

The View Headers/Footers command changes the view of the current document to

header/footer view which displays only the definitions of headers and footers that have

been inserted in the document Header and footer text can be edited only in header/footer

view This command is dimmed if you havent inserted any headers br footers into your

document

Note The default header and footer cannot be edited instead you must insert header or

footer to override the default

View Headers/Footers places the insertion point in the next header or footer defined after

the insertion point in page view or in the last header or footer if there are no more If

theres selection rather than an insertion point in page view View Headers/Footers starts

looking at the beginning of the selection for the next header or footer So choosing this

command when header or footer marker is selected will place the insertion point in the

definition of that header or footer

Tip As shortcut when the header or footer region is visible in page view you can

double-click in the header or footer region This will place you in header/footer view with

the insertion point in the definition of the header or footer you double-clicked
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View Footnotes

The View Footnotes command changes the view of the current document to footnote view

which displays only the documents footnote definitions Footnote text can be edited only

in footnote view This command is dimmed if you havent inserted any footnotes in your

document

View Footnotes places the insertion point in the next footnote defined after the insertion

point in page view or the last footnote if there are no more If theres selection rather

than an insertion point in page view View Footnotes starts looking at the beginning of the

selection for the next footnote

As shortcut when the footnote region is visible in page view you can double-click in the

footnote region this will place you in footnote view with the insertion point in the definition

of the first footnote displayed in that region

The Merge Command

The Merge command in the Document menu lets you merge information from one

document for example list of names and addresses into another document such as

form letter and print the results in this case version of the form letter for each name and

address You can also copy all the resulting form letters into one document to preview

them before printing them Since producing form letters is common use of the Merge

command well use the form letter example to introduce some terms and then show

specific example before giving further details

The document containing the original form letter is called the template document The

Merge command takes the document in the key window to be the template document

The document containing the list of names and addresses is called the data document

Each name and address in the data document is in separate paragraph called data

record For each data record version of the template document is produced the

template document itself remains unchanged

Data records are made up of fieldsfor example name and address fields The data

document gives names to the fields in names record The template document indicates

where to put the contents or value of each field each name and address in the form

letter

Each version of the template document each resulting form letter is called merged
document If you choose to print the form letters without previewing them the Merge

command just prints them and doesnt leave you with any documents containing the

lettersbut you can specify that they all be combined into one new document so you
can look them over
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Simple Example

To illustrate what the Merge command does this section presents simple example that

merges three names and addresses into form letter in template document and prints

merged document for each name and address

Suppose youve created data document named MailList.wn that contains the four

records shown below The first record the names record names the fields the remaining

records the data records supply the field values

recipient addresscitystateZI code

Steve Johnson222 Rose CourtPalisades ParkCA95014

Michele McColgan1 0257 Bakers LaneErievillePA1 5213

Jackie Neider54 North Street BerkeleyCA 94702

Youve also created template document in the same folder as the data document that

contains the following

DATA MailList.wn

recipient

address

city state ZIP code

Dear recipient

We think theres winner at address Please return the enclosed card so you

can claim your $2000000 prize

Congratulations

Fortune Sweepstakes

After opening the template document you choose the Merge command and as described

below click the button for printing the merged documents These three form letters are

printed each on its own page

Steve Johnson

222 Rose Court

Palisades Park CA 95014

Dear Steve Johnson

We think theres winner at 222 Rose Court Please return the enclosed card so

you can claim your $2000000 prize

Congratulations

Fortune Sweepstakes
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Michele McColgan

10257 Bakers Lane

Erieville PA 15213

Dear Michele McColgan

We think theres winner at 10257 Bakers Lane Please return the enclosed card

so you can claim your $2000000 prize

Congratulations

Fortune Sweepstakes

Jackie Neider

54 North Street

Berkeley CA 94702

Dear Jackie Neider

We think theres winner at 54 North Street Please return the enclosed card so

you can claim your $2000000 prize

Congratulations

Fortune Sweepstakes

How the Merge Command Works

After creating the data document and template document youre ready to give the Merge

command Be sure the template document is in the key window when you choose Merge

The command starts out by presenting the following panel

Merge
Parige 01 record to merge

All From ToJ

enil rierge1 doLumenteto

_________
Docunen1 1hrec1
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Normally all the records in the data document are merged into the template document To

merge only some of the records specify range of records in the From and To fields Type
for the first data record for the second and so on Completely empty records

paragraphs consisting only of Return character dont count in this numbering As

shortcut you can also click From which makes the words first and last appear in the

From and To fields respectively You can then leave the From field alone and specify

record in the To field or leave the To field alone and specify record in the Fromfield For

example to print from the first record to the tenth leave the From field unchanged and type

10 in the To field

Click New Document to copy all the merged documents into single new document This

new document will be untitled as when you create document with the New command use

the Save or Save As command to save it and give it name

Click Printer to print the merged documents the standard Print panel will appear

temporary untitled document containing each merged document as its about to be printed

will also appear

After you click Printer or New Document in the panel the Merge command reads the

template document and follows instructions in it that are enclosed in the symbols In

general these instructions identify what should be merged into the template document to

produce merged documents The template document itself isnt changed The name of the

data document is given in an instruction as in DATA MailList.wn and instructions

indicate where to put the field values in each merged document recipient acldress and

so on The Merge command repeatedly reads records from the data document and creates

merged documents inserting the field values where indicated each merged document starts

on new page As described below some instructions cause the Merge command to present

another panel such as one that asks for the value of field

If you want to try out the Merge command right now open the document named

WNTempiate.wn in /NextLibrary/Documentation/NextUser/Examples and then

choose Merge from the Document menu clicking whichever option you like Printer or

New Document It will read records from the data document named WNDataDoc.wn
which is kept in the same folder as WNTernplate.wn WNTemplate.wn shows how you

can omit an entire line from an address if certain item of data the company name in this

case is missing Everything this example illustrates is described in the following sections
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The Template Document

The template document contains instructions enclosed in the symbols which you get

by holding down the Alternate key while typing left and right parenthesis respectively

Altemate-Shift-9 and Alternate-Shift-O Any text not enclosed in these symbols is taken

literally that is copied as is into each merged document for example the text thats the

same in every form letter This section gives an overview of all the instructions theyre

described in detail later

The most commonly used instructions are

DATA for specifying the name of the data document This is typically the first

instruction in the template document

An instruction consisting only of the name of field defined in the data document The

value of the field is inserted where the name instruction appears in the template

document For example the template document might contain

Dear recipient

We think theres winner at address

Here recipient and address are fields defined in the data document these

instructions are replaced by values read from the data document

data document is only one possible source of information to be merged into the template

document Two other sources are

panel in which you enter field value presented by the Merge command when it

encounters SET or ASK instruction in the template document SET also lets you

specify the value of field in the template document itself

The entire contents of another document specified in an INCLUDE instruction This is

useful for combining several documents into one such as several chapters of manual

into single document

Other instructions that might appear in the template document are IF and ELSE so the text

thats merged into the template document can depend on the value of particular field

NEXT for advancing to the next data record and OMIT for omitting the current merged

document

Note Words that are shown in capital letters in instructions can actually be typed in any

combination of capital and lowercase letters

All characters not enclosed in the symbols including spaces and Return characters are

copied into the merged document So if you follow an instruction with Return that Return

will be copied into the merged document for example every form letter produced in

Simple Example above begins with blank line due to the Return character following the

DATA instruction For convenience when you want instructions on separate lines without
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including the Returns in the merged document you can omit the at the end of an

instruction following it only with Return In other words

instruction

instruction2

is the same as

instruction instruction2

The Format of the Data Document

The data document contains records of information to be merged into the template

document and associates field names with the various types of information Each record is

paragraph that may occupy any number of lines

As shown in Simple Example above the data document typically begins with names

record that specifies the names of the fields The names are separated by commas or Tabs

the last name in the record is followed by Return Spaces surrounding commas and Tabs

or preceding the final Return are ignored

Immediately following the names record are data records containing the individual values

for each field in the same order that the fields are listed in the names record like the field

names these values may be separated by commas or Tabs The data records are merged into

the template document in the order of their appearance in the data document

If field value contains comma Tab or leading or trailing space space at the

beginning or end enclose the value in quotation marks If value contains quotation

mark type the quotation mark twice and enclose the entire value in quotation marks For

example to set field to

J.R Bob Dobbs

enter the value

J.R Bob Dobbs

Note The only quotation mark recognized as such by the Merge command is the

symbols and are treated as ordinary characters

To leave field empty just type comma or Tab If the empty field or fields are at the end

of the record you can end the record there rather than have trailing commas or Tabs For

example suppose the data document contains

recipientaddresscitystateZIP code

Don JonesSmalltownCA9401

Emily AIlen90-27 3rd AvenueQueens VillageNY
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In the first data record above the address field is empty because of the consecutive commas
In the second data record the ZIP code field is empty because the record ends with the value

of the state field

completely empty data record paragraph consisting of only Return character will be

ignored no merged document will be produced for that record

Although the names record is usually in the data document it can also be in separate

document by itself see the next section for more information In either case it must be the

very first paragraph in the document

Specifying the Data Document The DATA Instruction

The instruction that specifies the data document in the template document usually has the

form

DATA datadoc

where datadoc is the name of data document containing names record followed by data

records For cases where the data has been produced by program that cant generate

names record its useful to have the names record in separate document the DATA

instruction would have the form

DATA namesdocdatadoc

where namesdoc is the name of document that contains only names record and datadoc

is the name of data document that contains only the corresponding data records If

document in the DATA instruction is WriteNow file be sure to add .wn to the file name

in the instruction

document specified in DATA instruction must be in the same folder as the template

document It can be WriteNow document or any other type of file that WriteNow can open

in which case it will be converted You can also substitute question mark for either

document name in the DATA instruction and the Merge command will present the standard

Open panel If you follow the question mark with message that message will appear in

the panel For example

DATA

presents the Open panel with no message for specifying the data document The

instruction

DATA FormFields.wnWhat is the data document

reads the names record from the document named FormFields.wn in the same folder as the

template document and requests the data document in an Open panel that displays the

message What is the data document Notice that the second question mark is part of the
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message The following example presents the Open panel with message for each

document in turn

DATA Select the document containing the names.Select the data document

The DATA instruction must appear before the first reference to field defined in the names

record

Note If there are any other DATA instructions after the first one theyll be ignored

Field Names in the Template Document

To indicate in the template document that you want to insert the value of field just enter

an instruction consisting of the name of the field

field name

The same field name may appear any number of times in the template document Each

occurrence of the name instruction is replaced by the value of the field The font properties

of the value in the resulting merged document will be the same as those of the name in the

template document For example if the template document contains

recipient

address

city state ZI code

Dear recipient

We think theres winner at address

the second occurrence of the address will be italic where it occurs in the resulting form

letter

Note The font properties of the value are actually determined by only the first character

of the field name as when you type text to replace selection

The field names in name instructions must be defined in the names record of data

document or separate document or in previous SET or ASK instruction Capital and

lowercase letters arent distinguished in field names for example ZIP code Zip Code
or zip code will insert the value of the ZIP code field

Conditional Instructions IF and ELSE

The IF instruction lets the text included in the merged document depend on the value of

field You can compare the field to particular value cityNew York income50000 or
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you can test whether the field has any value at all If the condition is met the Merge

command inserts text that you specify otherwise it inserts nothing or text that you specify

in an ELSE instruction

The IF Instruction

The form

IF field nametextENDIF

checks to see whether the field has value if so it inserts the specified text which may
contain any instructions as well as text to be taken literally If the field is empty as can

happen when there are successive commas or Tabs in the data document no text is inserted

For example suppose the template document contains

We hope to hear from you.lF ZIP code If you reply within five days recipient well

send you free gift ENDIF

The second sentence with the recipients name inserted will be included only if the ZIP

code field has value

The following forms of the IF instruction compare the field for equality and inequality

respectively to particular value

IF field name valuetextENDIF

IF field name valuetextENDIF

If the specified value is not number its compared literally character by character to the

value of the field The value in the IF instruction doesnt have to be enclosed in quotation

marks unless they would be required around it in the data document If the specified value

is number its compared numerically to the value of the field and other operators besides

and are allowed

Operator Meaning

Equal

Not equal

Less than

Less than or equal to

Greater than

Greater than or equal to

Numberhere means any of the standard numeric formats as in 12.3 and 1E1O The

following are not considered numbers

$12 because of the

20000 because of the comma
90-27 because of the hyphen
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For example suppose the template document contains

We want lF income50000 highly paidENDIF professionals like yourself to live at

Twin Oaks condominiums

If income is greater than 50000 this will yield

We want highly paid professionals like yourself to live at Twin Oaks condominiums

Otherwise the text highly paid wont be included

If you want number to be compared literally rather than numerically just enclose it in

quotation marks

The ELSE Instruction

The ELSE instruction can be used with any form of the IF instruction to specify alternative

text to insert if the IF condition isnt true

IF conditiontextELSEalternative textxENDIF

If the condition specified after IF is true the specified text is inserted as usual but if the

condition isnt true the text following ELSE is inserted For example form letter in

template document might contain

recipient

IF addressaddress ELSE General Delivery ENDIF

city state ZlP code

If the address field has value that value appears on the second line otherwise the words

General Delivery appear there

Nested IF Instructions

As mentioned above the text in an IF instruction may contain any instructions it may even

contain another IF instruction nested within it as in

IF condition IF condition2textENDIFENDIF

For example

iF stateCAIF cityMiddletownWe hope youll contribute to the future of your

home team.ENDIFENDIF

This sentence will appear only if the state is CA and the city is Middletown
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Setting Fields without Data Document SET and ASK

The SET and ASK instructions provide other ways besides the data document of defining

fields and supplying their values Here are the various forms of these instructions and what

they mean

Instruction Means

SET field name value Set field to specified value

SET field name message Present panel requesting field value display

SET field name specified message in panel or default message if

none is specified

ASK field name message Same as above but for each merged document

ASK field name

The form of SET that requests value does so only once the first time through the template

document subsequently this instruction is ignored so the value remains the same The form

that specifies value on the other hand takes effect each time through the template

document so IF instructions can contain this form of SET to conditionally change value

for individual merged documents

The message specified in SET or ASK instruction may contain other field names as in

ASK firstnameEnter Iastnames first name

The default message is What is the value of followed by the field name and question

mark The panel corresponding to an ASK instruction always displays the previous value

of the field for convenience if the new value is the same or similar The above example

might cause the following panel to be displayed

Metge

Enter Anderson first name

John

Stop Hege continue

In the following example the SET instruction sets the value of field in the template

document
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SET prize2 million dollars

You may have already won prize

The value specified in the SET instruction doesnt have to be enclosed in quotation marks

unless they would be required around it in data document as described above

The SET or ASK instruction can specify the same field name as one defined in the data

document it will override the value read from the data document if it follows the DATA

instruction

Including Other Documents The INCLUDE Instruction

The INCLUDE instruction merges all the text in specified document into the template

document As in the DATA instruction you can specify the document name in the

instruction or have the Merge command present the standard panel for specifying

document to be opened

Instruction Means

INCLUDE document Include specified document in same folder as

template document

INCLUDE Present panel for specifying included document

INCLUDE message Same as above but display message in panel

The included document may be WriteNow document or any other type of file that

WriteNow can open It may itself contain an INCLUDE instruction or any other

instruction

Advancing to the Next Data Record The NEXT Instruction

The Merge command automatically advances to the next data record when it reaches the

end of the template document you can also instruct it to do so sooner than that with the

NEXT instruction In this way values from more than one data record can appear in the

same merged document For example suppose youre creating mailing labels and you want

to have three labels per page Since each merged document begins on new page youll

have to combine every three labels into single merged document to do this you can set

up your template document as follows
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recipient

address

city State ZIP code

NEXT
recipient

address

city state ZIP code

NEXT
recipient

address

city state ZIP code

Omitting the Current Merged Document The OMIT Instruction

The OMIT instruction causes the Merge command not to create the current merged

document but instead to proceed to the next data record and the next merged document

starting all over again at the beginning of the template document For example if you dont

want to print form letter when the income field is less than 50000 you could include the

following instruction just after the DATA instruction in the template document

IF income50000OMIT ENDIF

Note You would not use the NEXT instruction here because even though NEXT advances

to the next data record it doesnt start all over again at the beginning of the template

document so the Merge command wouldnt check the value of the income field in the next

data record

Summaryof Merge Instructions

As summary and for quick reference later the following list shows every form of

instruction template document may contain
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Instruction Comment

field name Font properties are observed

DATA datadoc Same folder as template document

DATA Panel with no message

DATA message Panel with your message

DATA namesdoc datadoc Also or message for either document

IF field nametextENDIF True if field has value

IF field name valuetextENDIF Compared literally if quoted or nonnumeric

IF field name valuetextENDIF means not equal

IF field name numeric valuetextENDIF Also

IF field name numeric valuetextENDIF

IF conditiontextELSEaltemative textENDIF Condition may be any of those above

SET field name value Quotes optional as in data document

SET field name message Panel with your message

SET field name Panel with default message

ASK field name message Like SET but for each merged document

ASK field name

INCLUDE document Same folder as template document

INCLUDE Panel with no message

INCLUDE message Panel with your message

NEXT Doesnt restart at beginning of template

document

OMIT Restarts at beginning of template document
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Chapter

WriteNow Troubleshooting

This chapter presents some problems you may have while using WriteNow and suggests

an answer to each one The information here can also be found in other parts of this manual
but you may find it easier to look here for quick help when youre having trouble For

further details see the discussion of the pertinent concept or command in Chapter or

Problems while Editing

Youre confused about why text or the insertion point appears where it does

Something you cant see may explain the problem Try choosing Show Markers and Show

Space from the View menu Also look at the ruler for example you may have accidentally

centered paragraph that you meant to be left-aligned

Characters dont appear at the insertion point when you type instead they appear at

the end of the preceding line

Youve clicked at the beginning of line immediately following line in which you typed

too many Tab characters Choose Show Space from the View menu so you can see the Tab

characters and display the ruler so you can see exactly where the tab stops are Notice that

the line preceding the insertion point doesnt end with Return The problem is that when

you entered that line or edited it later you typed Tab character when there were no more

tab stops in that line You can solve the problem by pressing Return now while the insertion

point is at the beginning of the line below the one thats missing the Return

You cant move the insertion point to the right of the character at the end of line

If youre clicking in an empty area where theres no text or immediately to the right of

Return or page break character youre not doing anything wrong you just cant move the

insertion point there Otherwise youre probably clicking at the end of line in which you

typed too many Tab characters see the preceding problem

You moved or copied paragraph and it didnt seem to keep its origina format

If you move or copy paragraphs from one ruler width to another WriteNow scales the

margin indentation and tab settings adjusting them so theyre in the same relative places

on the new ruler This will happen for example if you move text between documents that
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have different page widths or column widths or if you copy text in multiple-colurrm

document from the body of page into header or footer

You cant select part of date or time in your document or line seems to be breaking

sooner than necessary the next line starts with date that could have partially fit on

the previous line

You inserted the date or time by choosing Insert Date or Insert Time from the Format menu

and clicking Updating Marker Choose Show Markers from the View menu and youll see

marker in place of the date or time Whether markers are being shown or hidden the date

or time inserted in this way is treated like single character You can only select it as unit

and it cant be split by line break

search for text seems not to succeed when it should

The Find Next command or the Next button in the Find panel starts searching at the

insertion point or end of the current selection Similarly the Find Previous command or

the Previous button in the Find panel starts searching at the insertion point or beginning of

the current selection If you want to search through the entire document from beginning to

end be sure to click at the beginning of it first To guarantee that the entire document will

be searched just keep Entire Document checked in the Find panel Also look at which other

options are checked for example be sure that Whole Word isnt checked when you want

text to be found within word

search for text seems to succeed when it shouldnt

If the current document contains the Symbol font family equivalent of character youre

searching for the Symbol character will also be found for example an in the Find field

will locate occurrences of as well as of

Spelling or Check Spelling doesnt seem to be finding spelling errors

The search starts from the insertion point or the last word in the current selection If you

expect the search to start from the beginning of the document be sure to click at the

beginning of the document first Also keep the following in mind

The spelling dictionary may not contain all the vocabulary used in your document but

you may add words with the Learn option

Its rare but possible that misspelled word will go undetected as side effect of the

compact encoding scheme used in the spelling dictionary
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paragraph jumps from one page to the next and back again while you edit

This may happen when you edit paragraph thats been kept on the same page or is part

of group of paragraphs that have been kept on the same page As you lengthen the

paragraph so that it no longer fits on the page it moves to the top of the next page and as

you shorten it so that it fits on the previous page it moves to the bottom of that page

Paragraphs are kept on the same page even though you never gave the Keep on Same

Page command for those paragraphs or Allow to Cross Page isnt reversing the effect

of Keep on Same Page

WriteNow forces Keep on Same Page on any paragraph containing graphic taller than

the header-body separator which is initially 24 points and can be set with the Page Layout

command This cant be reversed with the Allow to Cross Page command If you dont want

all lines of the paragraph to be kept on the same page try setting the header-body separator

to the height of the graphic

Header/Footer Problems

header or footer doesnt appear where you think it should

The location of header or footer definition determines which pages the header or footer

appears on Choose Show Markers from the View menu and check whether theres more

than one header or footer defined on page if so the first header defined on the page

appears at the top of that page and the last footer defined on the page appears at the bottom

If no header or footer is defined on page the last one defined in the document is displayed

Also if header or footer that appears on the screen doesnt appear in the printed document
it probably falls in the narrow area approximately 1/4 inch or mm around the edge of

the page where nothing will print move the header down or the footer up by adding blank

line at the beginning of the header definition or at the end of the footer definition

You shortened header or footer to have fewer lines but its the same height as before

on each page

The height of the header or footer region is always the same on every page equal to the

height of the tallest header or footer defined in the document Space is added below any

shorter headers or above any shorter footers to make the region the appropriate height
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You edited header or footer and now your pages break in different places than

before

You added or removed line from header or footer with the result that it changed the

height of the tallest header or footer This changed the height of the header or footer region

which in turn changed the height of the body of the page causing page breaks to be

different

Body text collides with the header at the top of page

The header-body separator in the Page Layout panel needs to be increased to the height of

the tallest line in the paragraph thats colliding with the header Remember that line height

is determined by line spacing as well as by font size

Other Problems

In multiple-column document the tops of the columns dont appear to be lined up

properly

To save time during editing WriteNow will not line up the columns properly on the screen

however the columns will be lined up properly in the printed document

When you open new document it doesnt look the way you expect it to look

Your new documents will have nonstandard initial format if theres document named

Stationery.wn in your home folder an untitled copy of that document will be opened when

you choose the New command If you expected nonstandard initial format that you set up

in Stationery document be sure that you spelled the name of the stationery document

correctly for example not Stationary.wn and that its in your home folder

Every time you open new document you get message about the system having

changed and the fonts being checked

The fonts in the file system have changed since you created your Stationery document

Opening Stationery.wn directly and then saving it will solve this problem

When you close document or choose Quit WriteNow presents panel asking

whether you want to save changes to the document even though you havent made any

changes since the last time you saved the document

Occasionally youll see this panel when you havent made any editing changes yourself but

have performed operations that caused WriteNow to make some internal changes to the

document
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When you try to open WriteNow document panel appears saying that the

document file is currently in use by you but you dont have the file open

The last time you worked in the file the WriteNow session ended abnormally and the file

wasnt properly closed This would happen if there were power failure for example or if

you killed WriteNow using the Workspace Managers Processes command

Because the file wasnt properly closed WriteNow didnt remove the files lock which

warns users trying to open the file that someone is currently working in it When you

opened the file subsequently WriteNow incorrectly perceived it as still being open

Normally opening file thats currently in use by someone else can cause damage to the

file However since the file isnt really open you can open it safely Click the Open

Anyway button in the panel and again in the second panel that appears When the file opens

you can work in it as usual
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Part

The Digital Library

digital library is an on-line collection of informationincluding for example reference

works documentation and literaturethat can easily be accessed with NeXT application

designed for that purpose The NeXT Digital Library is provided with your computer

digital libraries are also available from other companies and you can even create your own

Included in the NeXT Digital Library are

Websters Ninth New Collegiate Dictionary and Websters Collegiate Thesaurus

Selected NeXT user documentation chapters

The extended release of the software also includes

The Oxford Dictionary of Quotations

The manuals in The NeXT Developers Library for developers of NeXT applications

Notes for application developers about the latest release of the software

Reference documentation for UNIX commands

You use the applications described in Part 2Digital LibrarianTM Digital WebsterTM and

in the extended release Digital Quotationsto find information in the NeXT Digital

Library With Digital Librarian you can access or create other libraries These applications

provide sophisticated search tools that let you quickly locate the information you need

The chapters in Part describe the library applications

Chapter describes Digital Librarian which provides quick access to information in

digital libraries

Chapter describes Digital Webster which you can use to look up words in Websters

Ninth New Collegiate Dictionary and Websters Collegiate Thesaurus

Chapter describes Digital Quotations which finds literary references in The Oxford

Dictionary of Quotations

In each chapter the first section introduces the applications basic features and concepts

while the remaining sections provide details about the applications buttons and commands
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Chapter

Digital Librarian Searching for Information

________ The Digital Librarian application lets you quickly locate information in digital library Its

like having your own personal librarian whos always available to find the information you
need

You can start up Librarian directly from the application dock or File Viewer in the

Workspace Manager or from within another application if that application has Services

menu with Librarian command in it as described in the NeXT Users Reference manual

To locate information you provide Librarian with word or words that you want to look

up in the library files Librarian searches in selected target folders and displays one-line

identification of each file that contains the word You can then select files from the list to

view their contents

For example if you wanted to learn about Preferences youd select NeXT User as your

target and search for the word Preferences Librarian would display list of files

containing that word Double-clicking file in the list displays the user documentation in

that file

Library Bookshelves

Librarian searches in
targets

that you select among collection of targets called bookshelf

Bookshelves are similar to documents in word processor in that you can use commands

like New Save and Open in the Bookshelf menu to create bookshelves save changes you
make to them and open more than one at time

The first time you start up Librarian it opens bookshelf containing the following target in

the NeXT Digital Library

Target Contents

NeXT User Selected chapters from NeXT user documentation

including this chapter and some WriteNow examples

If you have the extended release of the software you also see the following Digital Library

targets
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Target Contents

Developer RelNotes Notes for application developers about the latest release of

software

NeXT Developer The manuals in the NeXT Developers Library for

developers of NeXT applications

UNIX Manual Pages Reference documentation for UNIX commands

Bookshelves are stored in files that have .bshlf extension The bookshelf containing the

targets
listed above is in the file /NextLibrary/Bookshelves/Librarian.bshlf In the

extended release of the software theres another bookshelf in /NextLibrary/Bookshelves

named Literature.bshlf that has as its target the Oxford University Press edition of

William Shakespeare The Complete Works

The first time you start up Librarian it copies /NextLibrary/Bookshelves/Librarian.bshlf

to file by the same name in Library/Bookshelves in your home folder this enables you

to customize that bookshelf as you like for example by adding targets to it If you want

Librarian to open different bookshelf when you start it up just copy the bookshelf you

want to Library/Bookshelves/Librarian.bshlf in your home folder

In addition to opening bookshelves within Librarian you can open bookshelf files directly

in the Workspace Manager Librarian starts up if it isnt already running and displays the

bookshelf you opened

Using Librarian

When Librarian starts up it displays bookshelf window like the one shown below In the

extended soitware release you 11 see more targets

targetarea
---

NTUer
-- resize knob

query box icon well

6exch Titi

summary area
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The icons in the target area represent the targets in the bookshelf Before performing

search you need to select the target or targets you want to search in Clicking selects

single target Shift-clicking selects or deselects additional targets

After selecting the targets you enter word or words in the query box and click the Search

button or press Return Librarian searches through the selected targets for files that

contain your query

In the summary area Librarian lists the files it found If the list is too large for the summary

area scroller appears that you can use to view the rest For example heres what you

might see if you searched for Preferences in the NeXT User target

tie TIkr

JPeirric

THUIId rch litip

Itt r1c1TCumrrTaTd

Lib-tutirt1i

1iICtnrrimd rttcl

-- --

ou can then open one or more ot the lile Librarian found as follows

To open one of the files click its line in the summrv area its icon will appear in the

icon well and then choose Open from the File menuor as shortcut double-click

the line in the summary area You can also open the file by double-clicking its icon in

the icon well

To open more than one file at time you can select them all in the summary area

Shift-clicking to select additional files then choose Open from the File menu or

double-click the icon in the icon well

Each file opens in its own window either within Librarian or in another application

If the file is plain ASCII RTF or nroff UNIX text format it opens in Librarian

window called text window described in the next section unless you used the

Preferences command in the Info menu to make such files open in the Edit application

Other files open as if opened from the Workspace Manager For example if its

WriteNow file WriteNow starts up if its not already running and displays the file
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highlighting the first occurrence of the querys first word You can remain in the

application or switch back to Librarian the application keeps running until you quit it

If you want to copy the selected file or files into another application such as into another

folder in the Workspace Managers File Viewer or into Mail message you can drag the

icon from the icon well just as you can from folder window in the Workspace Manager

To list all the files in the selected targets without entering query in the query box click

the Titles button in the bookshelf window You can open the desired files from the summary

lines as usual

The Librarian Text Window

text window in Librarian looks like this

-NTØr
____

Note The Find button is replaced by the New Ivialibutton when manual retrieval of mail has been chosen formore

lnfonn3laon see the description of Prethtesrn commandin the Info menu under Mail Commands below

Arrows

The rrow burton allow you to browseamessase at timethrough the messages listed in the summary area of the

iniilbo window Th up arrow selects the message immediately above the current message the down arrow selects

the snesige immediately below the current message The newly selected message is displayed in the message area

The Return key performs the same operation as the down arrow and Shift-Return performs the same operation as the

up arrow

Delete

The text windows title bar shows the name of the file its in The area at the top of the

window where the Find and Search buttons are located shows the targets label

The first occurrence of the querys first word is highlighted in the text window You can

click the Find button in this window to locate the next occurrence of that word in the file

or use the commands in the Find menu to locate other words
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You can scroll through the text in the text window or print it with the Print command
Although you cant edit text displayed by Librarian you can copy it with the Copy
command and paste it elsewhere for editing

Note Since you cant insert text in the text window an insertion point doesnt appear when

you click there

If you see word in the text window that you want to use in another search you can select

it and click Search Librarian returns to the bookshelf window and searches for the text in

the selected targets

Indexes and Searching

What enables Librarian to search target especially quickly is the targets index The index

lists all the words that you can look up in the target and gives the locations of those words

in the targets files Rather than search through the text of the files Librarian just looks up

your query in the index and quickly goes to the location given for it

The targets in the NeXT Digital Library come with indexes already built for them When

you add new target to bookshelf you can ask Librarian to build an index for it

Files are indexed by filters that can interpret the format of the file being indexed Your

NeXT computer comes with filters that can index plain ASCII RTF nroff and WriteNow

files Indexing filters for additional file formats may be provided by other companies for

example another word processor that you buy for the computer may come with filter that

allows you to index files it creates

Searching Without an Index

Librarian allows you to search both indexed and unindexed targets the words Unindexed

Target appear above the query box when you select an unindexed target Even if target

has an index you dont have to use it you can switch Use Indexes off with the Preferences

command When not using an index Librarian searches the entire text as would the Find

command

Searching an indexed target is much faster but there are some reasons you might want to

do an unindexed search

As explained below not all words in the target are indexed excluded words wont be

found in the index but would be found in an unindexed search

For indexed targets multiple-word query directs Librarian to find files that contain

the specified words anywhere in the file even if not adjacent In an unindexed target

the search will succeed only if the file contains exactly whats entered in the query box

which may be preferable
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Indexes occupy disk space You might want to delete an indexor not create oneto

save space

Whats In an Index

Librarians standard indexing scheme creates indexes containing all words of two or more

letters other than very common English words such as the like and me Two kinds

of plain ASCII files exclude certain additional words from their indexes

Source files for programs indexes for these files dont include words that have

special meaning in such as char and else

Mailbox .mbox files from the Mail application indexes for these files dont include

words Mail itself uses such as received date and reply-to

Normally as it indexes any target Librarian removes all punctuation except hyphens

apostrophes and underscores word that contains hyphen apostrophe or underscore is

indexed as single wordfor example dry-dock is indexed as one word not two

When you add
target to bookshelf you can either index it according to the standard

scheme or customize its index

Note For programmers who want to create custom indexing scheme for example for

format not currently supported by Digital Librarian information is provided on-line in the

extended release of the software in the NeXT Developer target of the Digital Library its

in the file /NextLibrary/Documentation/NextDev/Notes/Indexing.rtf

Adding and Removing Targets

You can specify any number of folders as targets in bookshelf To add target folder use

the Workspace Manager to display an icon for the folder then drag the icon into the target

area in the bookshelf window Librarian labels the target with the folders name if you

prefer different label edit the name under the target and save the bookshelf You can

move targets around in the target area by dragging them and you can enlarge the target area

by resizing the bookshelf window to make it wider or by dragging the target areas resize

knob down

Note Targets may be files as well as folders but only target folders can be indexed

The folders that correspond to the NeXT Digital Library targets are located in the

/NextLibrary folder Within /NextLibrary/Documentation the folders beginning with

Next contain NeXT documentation other folders in /NextLibrary/Documentation

contain documentation from other companies for their software thats provided with the

computer
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You can index any folder that you have permission to write in If you have write permission

choose the Index command from the Target menu to create an index for the new target

Permissions for the Documentation folder of /NextLibrary and the Literature folder of

/NextLibrary in the extended software release have been set up so that you have write

permission for folders that contain indexable files but not for those that dont

To remove target from Librarian drag it out of the
target area Removing target does not

remove the folder or its index from the file system so you can remove and add target

without rebuilding its index Whenever you add target that already has an index Librarian

simply accepts the target and uses its index To delete an index from the file system use

the Index command

Librarian Buttons

The bookshelf window buttons are described first followed by the text window buttons

Bookshelf Window Buttons

Search or Stop

The Search button in the bookshelf window searches for files containing the text specified

in the query box or files containing that text in their name With the Preferences command

in the Info menu you can limit the search to either file contents or file names

In the query box you can type single word or combination of words see Entering

Query below and then click Search or press Return to begin the search All targets

selected in the bookshelf window are searched

During the search Librarian ignores capitalization It searches for

Full words only unless youve used the Preferences command to specify that you want

to search for prefixes too or for text appearing anywhere even mid-word

Indexed words only unless youve switched off Use Indexes with the Preferences

command

In the summary area Librarian lists all the files it finds arranged in alphabetical order under

each target unless youve chosen different sort order with the Preferences command

Usually files are identified by pathname and some text from the very beginning of the tile
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small icon next to each file name identifies the file type The icon for WriteNow files is

the icon for RTF files looks like and nroff files are represented by Plain ASCII

files that are indexed with the standard indexing scheme have this icon plain ASCII files

that have unique indexing schemes have unique icons For example the icon for source files

for programs is mailbox files are represented by If Librarian doesnt recognize

files type the icon in the summary area looks like this

You can open file by selecting it in the summary area and choosing Open from the File

menu by double-clicking it in the summary area or by selecting it and clicking its icon in

the icon well If the file is plain ASCII RTF or nroff file it opens in text window in

Librarian unless you used the Preferences command to make the file open in the Edit

application other types of files open as if opened from the Workspace Manager

While Librarian is searching the Search button changes to the Stop button You can stop

search at any time by clicking Stop files found before then are listed in the summary area

Entering Query

Your query will often be single word resulting in list of all the files containing that word

In some cases you might decide that you then want to refine the search to for example list

the subset of the files previously found that also contain second word The Preferences

command in the Info menu lets you specify search criteria in this way as described in detail

later in the Librarian Commands section

The following table shows how when searching an indexed target you can instead qualify

search when you first enter query by specifying combination of words joined by and
or and not with and being assumed between consecutive words This type of query

doesnt work when you search an unindexeci target because in that case the query text is

taken literally and searched for exactly as it appears

Query Finds

word and word2 Files that contain both words whether or not the words

word word2 are adjacent in the file

word word2

word or word2 Files containing either word or files containing both

word word2 words

word not word2 Files that contain the first word and do not contain the

word word2 second word

Note You can also use and not in place of not
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You can use these joining words together or separately and theres no limit to the number

of words you can combine with them Librarian reads your query from left to right

grouping words in that order For example if you type

Mail or WriteNow and Preferences

Librarian interprets this as Mail or WriteNow and Preferencesthat is it finds all of

the following

Files that contain Mail and Preferences

Files that contain WriteNow and Preferences

Files that contain Mail WriteNow and Preferences

However if you type

Preferences and Mail or WriteNow

Librarian interprets this as Preferences and Mail or WriteNow and finds

Files that contain Preferences and Mail
Files that contain WriteNow
Files that contain Preferences Mail and WriteNow

ri ties

The Titles button lists in the summary area all the files that are in the selected targets It

ignores any query in the query box

Text Window Buttons

Search or Stop

The Search button in the text window searches for the text selected in that window just as

if it were query in the bookshelf window It returns to the bookshelf window enters the

text windows selection into the query box and performs the search
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Find

Find

The Find button has the same effect as the Find Next command in the Find menu It selects

the next occurrence of the text specified in the Find panel It starts looking for the text at the

end of the current selection goes to the end of the text in the file continues at the beginning

and stops back where it started When you open file Librarian places the first word of the

query in the Find panel and finds that word for you

Librarian Commands

II1Tgli

IflfÔ

Targt

Edit

Widthis-

Servities

P.riæt

Hide

Quit

Librarians main menu contains the standard Windows Services Print Hide and Quit

commands The Bookshelf menu contains the Open New Save Save As Revert to Saved

and Close commands for opening and creating bookshelves The Format menu contains the

Font and Page Layout commands All these standard commands are described in Users

Reference The other commands in the main menu and commands in their submenus are

described below

Info

Th

lno P.aheL

Preferences..

HeI
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The Info menu contains the standard Info Panel command plus Preferences command
and Help command

Preferences

The Preferences command lets you set specific conditions for search and for the display

of results The choices you make stay in effect for the current bookshelf until you change

them

45peneo in Litrarrn

1atch -Searcf

Full wnrd Frt ndrnes

Pratts CnnteriL

An here Both

JRequIarEpresion ju aindes-

ResUlts oa

CNev phbeticU

CReflne

CiŁige sywiight

urt

Open thxtflles in Librxiari

If this box checked Librarian opens plain ASCII RTF and nroff files in text window

Otherwise these files arc opened as if from the Workspace Manager usually this means

theyre opened in the Edit application although with the Workspace Managers Inspector

command you can arrange for the files to open in different application You can edit the

files in the Edit application if file is read-only you cant save your changes but you can

print the edited version See the NeXT Development Tools manual in the NeXT Developers

Library for more information on the Edit application

Full vord

An where

Normally Lihranian searches by Full Word that is it finds only words matching exactly

what you enter in the query box You may instead prefer searching by Prefix which finds

all words that begin with as well as match your query If you want to find the query text

anywhere it appears possibly in the middle of word click Anywhere
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This feature is implemented primarily for expert UNIX users If Regular Expression is

checked Librarian allows queries to be regular expressions as defined in UNIX text

editors For more information on regular expressions see the UNIX manual page for ed

UNIX manual pages are available on-line only in the extended release of the software

..

Librarian usually searches for the query in both the names of the files and in the file

contents You can choose to limit the search to either one of these options

If Use Indexes is checked Librarian searches for words in the targets index if any
otherwise it searches the entire text of each file for the query text For more information

see Indexes and Searching earlier in this chapter

Tip Searching for indexed words is faster so you may want to search for indexed words

first and then if you dont find what youre looking for switch Use Indexes off

These preferences affect the results of the next search Normally the New option is in

effect the other options cause the results of the next search to be relative to the results of

the previous search Remember to switch back to New when you want to resume doing

regular searches

Option Results of Next Search

New Results of the next query as usual replacing the previous results

Refine Subset of results from the previous query that also contain the next

query that is it lists the files that match the previous query and the

next query

Merge Files from the previous query and any additional files from the selected

targets that match the next query that is it lists the files that match the

previous query or the next query

Exclude Files from the previous query that do not match the next query If you

use the Titles button next instead of Search it lists all the files in the

selected targets that were not previously listed
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Note that selecting Refine Merge or Exclude before using Search has the same effect as if

you had used and or or not in the original query For example searching for open and

workspac yields the same results as searching for open clicking Refine and then

searching for workspace The Results preferences are provided for when you belatedly

decide to modify the search criteriafor example you might decide to refine search after

seeing that very large number of files were found

..

Files in the summary area are listed alphabetically unless you select one of the other Sort

options

The Alphabetically option arranges the summary lines in ASCII order alphabetical

but with capital letters preceding lowercase for more information see Users

Reference

By date arranges the lines chronologically by date and time of file creation or last

modification with the most recent first

By weight sorts according to how many instances of the query each file contains the

files that contain the most instances are listed first

Unsorted lists the files in the order in which theyre found

Help

The Help command brings up bookshelf window that contains single selected target

Librarian 1-leip To get help on specific topic enter the topic in the query box and click

Search

Target
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Index

To create an index for new target or to delete update or rebuild an existing targets index

select the target and choose the Index commandor as shortcut double-click the target

An example of when you might want to rebuild an index is when having previously

deleted the index to save disk space you decide you want it back

The Index command opens panel containing the selected targets pathname index

information such as date last modified size and owner and buttons for deleting

updating or creating its index When you dont have permission to index folder these

buttons are disabled

The Index Panel

panel like the one shown below comes up when you choose the Index command or

double-click target If youve selected several targets an Index panel appears for each

one

V_V

/netJuaFdlan pub jcapeia Corn positing

No rsent -V

Pl-4e Cdte Ic7

Deete Index

The Delete Index button is dimmed if the target doesnt already have an index or if you

dont have permission to delete the index otherwise it deletes the targets index from the

file system When you click Delete Index another panel appears asking whether you really

want to delete the index click Delete if you do or Cancel if you dont

Note If you delete an index you can rebuild it later by clicking Create Index

Oie Index Upda Index

The label of this button depends on the target If the target doesnt have an index the button

is labeled Create index if the target already has an index the button is labeled Update
Index Create Index builds an index from scratch Update Index lets you index all changes

made to the
target since it was last indexed or finish creating or updating partially built

index
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TJze Indexing Process

During indexing the Index panel shows the status of the indexing process and allows you
to halt it When file is being indexed its name and icon appear in the top left of the panel

just above the date As Librarian indexes each file it places the words it finds in the targets

index

During indexing the label on the Create Index or Update Index button changes to Pause

/neti cj uar dianfpubs/jcapela/ Corn positing

LI Thesh

Date Ji 7989

size cUis regabytes

Owner je
Tt

If you click Pause Librarian finishes indexing the file currently being indexed then stops

indexing Files that it just indexed are added to the targets new or updated index the

remaining files are not Clicking the Update Index button later will index the remaining files

and acid them to the targets index

Copyright

The Copyright command displays in text window the copyright information if any for

the selected target

File

Qpe
Opefl FoIde -0

The commands in the File menu apply to the file or files selected in the summary area
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Open

The Open command opens plain ASCII RTF or nroff file in text window in Librarian

unless you used the Preferences command to specify that such files open in the Edit

application Other types of files are opened as if from the Workspace Manager

Open Folder

The Open Folder command displays the folder containing the selected file in Workspace

Manager folder window

Edit

rE

cut

coPy

Past

TId
Selpit fl

The Edit menu contains the standard Cut Copy Paste and Select All commands as

described in Users Reftrence Cut and Paste work only in text fields not in text windows

Find

The Find menu contains the iandard Find menu commands as described in Users

Refrreiue The Find Panel command brings up the panel shown below

FIdI

Prnous Not

Librarian automatically places in the Find panel the first word of every query it searches for

and immediately after the search locates that word for you in the text or application

window You can enter other text by typing or using the Enter Selection or Paste command

The Find Next command like the Find button in the text window and the Next button in the

Find panel selects the next occurrence of the text specified in the Find panel The search

for the text begins at the end of the current file and continues at the beginning of the text

window when it reaches the end The Find Previous command Or the Previous button in

100 Chapter Digital Librarian Searching for Information



the Find panel works the same way only it starts at the beginning of the current selection

and goes backward
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Chapter

Digital Webster Dictionary and Thesaurus

Digital Webster is an application that provides access to the popular reference guides

Websters Ninth New Collegiate Dictionary and Websters Collegiate Thesaurus

The Webster application supplies nearly all the information found in the hardbound

editions and adds powerful search capabilities such as cross-referencing and spell

checking

Using Webster

Many applications have Services menu that includes Define in Webster command if you

select word or phrase and choose Define in Webster it starts up Digital Webster if its not

already running and searches for the definition You can also start up Webster directly from

your workspace

Webster displays window like the one shown below

query box ji twj
Definº Find DictIonTheauruI

text area

An open book on the Dictionary button or the Thesaurus button means that Webster will

search for words in that book clicking these buttons opens and closes the books You can

have either book or both books open

You can look up any word or phrase that might be found in dictionary or thesaurus by

entering it in the query box and clicking the Define button or pressing Return
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Depending on which books are open Webster displays dictionary or thesaurus entries or

both in the text area For example

reseirch

re.search ri-srcli rt-\

fr recerc/irerto investigate thoroughly fr OF fr re- a-rc/rier

to search more at sEznca

carefuul or diligent search

studious inquiry or examination esp investigation or experimentation aimed

t.tthe discovery and interpretation of facts revision of accepted theories or

laws in the light of new facts or practical application of such new or revised

theories or laws

the collecting of information about particular subject

-research ut

1S93

to search or investigate exhaustively resewch problem

to doreseirchfor en book

In the extended release of the software any illusti alion that accompanies definition is

shown in separate window

If you want to look up word thats displayed in the text area you can select it and click

Define

You can print the definition and illustration if available with the Print command or copy
the text with the Copy command and paste it into another application for editing but you
cant edit the text in the text area

Webstei- also doubles as spelling checker If you try to look up word that resembles but

doesnt exactly match word in the dictionary Webster lists alternate spellings in the text

area You can then select the word you want to look up and click Define

Webster Buttons

Define

Define
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The Define button looks up the word or phrase thats in the query box and displays

dictionary entries thesaurus entries or both in the text area whats displayed depends on
the settings of the Dictionary and Thesaurus buttons

You can type word or phrase in the query box and then click Define or press Return

Alternatively you can select text in the text area and click Define or hold down the

Command key while selecting text Webster will enter the text in the query box and then

look it up

When looking up the query Webster ignores capitalization and any characters other than

letters and numbers For example entering any of the following in the query box will

display the definition for grown-up grown-up grown up grown-up or Grown Up

When Webster doesnt recognize word it displays list of alternatives and enters the first

alternative in the query box You can click Define to look up that alternative or select

another one from the list before clicking Define

Repeating Searches

Webster keeps list of all the queries its looked up during the current session Click jto
display the previous query or to display the next query and then click Define

Tip If you look up word in list of alternatives displayed by Webster and then want to

return to the list to look up another word in it you can click fj and then Define to display

the list again

If youve looked up word and want to see the previous or next entry in the dictionary

hold down the Alternate key while clicking to display the previous entry or to

display the next entry and then click Define

Find

1i
41
The Find button has the same effect as the standard Find Next command in the Find menu

In the text area it selects the next occurrence of the text specified in the Find panel It starts

looking for the text at the end of the current selection goes to the end of the text area

continues at the beginning of the text area and stops back where it started Webster

automatically places in the Find panel the first word of every query it looks up
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See Find in the commands section below for more information about Websters Find

menu commands

Dictionary and Thesaurus

Dictkna .Theuru.5

These buttons determine what books Webster looks in when you click Define if the book

on the button is open that book is searched Clicking the button opens and closes the book

Either or both of them may be open

Webster Commands

tnfo

Edit

Find

Ptiæt.

H1d
uit

Websters main menu contains the standard application commands Edit Page Layout

Print Services Hide and Quit as described in the NeXT Users Reference manual The

other commands in the main menu are described below

Info

arm

Cnntent .V
PrdæUæciatiôii

HØIp

Prefeiences
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In addition to the standard Info Panel and Help commands the Info menu includes

Contents command Pronunciation command and Preferences command described

below

Contents

The Contents command opens window for displaying introductory and explanatory

material from the dictionary and thesaurus The Contents window displays list of topics

click topic to display the corresponding text in the windows text area

Prfac

Etork1Staff --

Explnrory Notes-- Entries

Explanatory Notes

Entries

L11
boldface letter or corcLorLauoo-L ot such letters set flush With the left-hand margin of each

culixcon of typo is main entry or eiLtry WOrd The main entry may consist of letters set

solid of letters joined by hyphen Ut ufletters separated by one or more spaces

The topics include notes on pronunciation and etymology as well as handbook of style

with sections on punctuation capitalization and other style-related subjects There are

more topics than can lit in the summary area scroll to see the rest

You can use the Find menu to locate specific text in the Contents windows text area

Pronunciation

The Pronunciation command displays panel containing Websters pronunciation key You

can use the Contents commands to see the Guide to Pronunciation which explains the

meaning of the pronunciation symbols
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Preferences

The Preferences command opens panel letting you specify your preferences for searches

and displays Your choices remain in effect from one work session to the next

FuIIVZortI Pre1x

oId Word Other Word

.-WrÆt-FontSizŁ

.JPtit Set r.1

The Search By switches determine the search method that Webster uses when looking up

queries To change the setting of one of these switches click the switch itself or the label to

its right or left

FuliWord

When searching by Full \Vord Webster finds only words matching your query exactly You

may instead prefer searching by Prefix which finds all words that begin with as well as

match your query

Bold Word Other 1rd

Normally Vehtcr searches by Bold Word Only definitions in which the query appears in

bold are displayed bold words include main entries as well as their associated variants

inflected forms and derived forms For example if you search for superconductor by

Bold Word Webster displays the definition of superconductivity along with the

associated form superconductor

In the extended release of the software you can also search by Other Word in which case

all other definitions that include the query are displayed instead If you search for

superconductor by Other Word Webster displays only the words whose definition

contain superconductor theres one such word supercurrent

Note The Bold Word/Other Word switch applies only to the dictionary not to the

thesaurus
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Pictures

Print

In the extended release of the software when definition includes an illustration Webster

displays and prints the illustration along with the definition By clicking these boxes to

remove the check mark you can choose not to display the illustration or not to print it or

both If you dont have the extended release of the software these check boxes are

dinmed

The lbnt size of the text in the text area of the main application window is normally 12

points you can change it by typing the font size you want in the Font Size field and then

clicking the Set button This also determines the size of the text when its printed from

Webster

Find

The Find menu contains the standard Find menu commands as described in Users

Reference You can use these commands to locate text in the text area of either the Webster

application window or the Contents window whichever is the main window The Find

Panel command brings up the panel shown below

Firidi

Pe/tUsf

Webster automatically places in the Find panel the first word of every query it looks up You

can enter other text in the Find panel by typing or by using the Enter Selection command

or the Paste command

The Find Next command like the Find button in the application window and the Next

button in the Find panel selects the next occurrence of the text specified in the panel the

Find Previous command or the Previous button in the panel locates the previous

occurrence The search for the text begins at the end of the current selection in the text area

or at the beginning of the current selection if Find Previous
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When looking for text in the main application window Webster continues at the beginning

of the text area when it reaches the end When searching in the Contents window however

Webster looks through the text of all the listed topics when it reaches the end of the current

topic it looks through the next one and so on continuing at the first topic when it reaches

the last one in the list
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Chapter

Digital Quotations The Oxford Dictionary

_________ The Digital Quotations application available only in the extended release of the software

provides quick access to the entire collection of literary quotations found in The Oxford

Dictionary of Quotations You can search for quotations by providing word that might

appear in quote or an authors last name For example if you wanted quotes on the topic

of information youd search by the word information if you wanted quotes by Mark

Twain youd search by the authors name Twain

Using Quotations

When Quotations starts up it displays window like the one shown below

query box
I.j d4 Word/Author button

SeÆrh
_________

text area

--
The Word/Author button in the Quotations window determines the search method clicking

the button switches between its two settings Depending on the method you choose you

enter either word or words or an authors last name in the query box

To start the search you click the Search button or press Return When the search is

complete the quotations appear in the text area displayed under their authors name For

example

Using Quotations III



bejie.ve it has been said that one copy of Th.o Tnn.zs contains

InUre etul then the hole of the In tonsi vorI

of Thucydides

Speech ceonchester Dcc 1250

CHARLES DICKENS 151 218O if

DAVID COPPERFIELD

only ask for information Rosa Dartle if

ch.20

T.S ELIOT 15S519d5 if

Whereis theLifewehavelostinlivingl if

Where is the wisdom we have lost in knowledge

Whose is the knowledge we have lost in information

C1IoUwes fro floe 5lok fL

PRESIDENT THOMAS JEFFERSON 1741196

If you searched by word the first occurrence of the first word in the query is highlighted if

you searched by author the first occurrence of the authors last name is highlighted You

can click the Find button to locate the next occurrence or use the commands in the Find

menu to locate other text

You can scroll through the text area to look at the clLtotes or you can print them all with the

Print command You can also copy them with the Copy command and paste them into

another application for editing but you cant edit them in the text area

if you see word or name in the text area that you want to use in another search you can

select it and click Search Quotations will search for the text by the method chosen with the

Word/Author button You can also initiate search from within another application if the

application has Services menu that contains Search in Quotations command as

described in the NeXT Users Reference manual

Quotations Buttons

Search or Stop
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The Search button searches for quotes that correspond to the query entered in the query box

The query may be one or more words or author names depending on the setting of the

Word/Author button for details see Word or Author below

You can type your query in the query box and then click Search or press Return

Alternatively you can select text in the text area and click Search or hold down the

Command key while selecting text Quotations will enter the text in the query box and then

search for it

During the search Quotations ignores capitalization and all characters other than letters and

numbers However you can search for hyphenated word by entering it as two words

without the hyphen For example entering far reaching will find quotes containing

farreaching

As it searches Quotations reports its progress just below the query box It displays the

number of quotes its found if you searched by word or the number of authors if you

searched by author At the end of search all quotes that were found are displayed in the

text area and the first occurrence of the first word in the query is highlighted Quotes are

listed under their authors name Many quotes also include source reference

While Quotations is searching the Search button changes to the Stop button You can stop

search by clicking Stop quotes found before then are displayed in the text area

Repeating Searches

Quotations keeps list of all the words or names youve searched for during the current

session Click to display the previous queiy or to display the next query and then

click Search

Find

i1i21

The Find button has the same effect as the standard Find Next command in the Find menu

In the text area it selects the next occurrence of the text specified in the Find panel It starts
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looking for the text at the end of the current selection goes to the end of the text area

continues at the beginning of the text area and stops back where it started Immediately

after searching for query Quotations automatically places the first word of the query in

the Find panel and locates that word for you in the text area

See Find in the commands section below for more information about Quotations Find

menu commands

Word or Author

The Word/Author button determines which type of query you should enter in the query box

or select in the text area You can search by word or by an authors last name click the

button to switch between its two settings

When you search by word your query should be one or more words or combination of

words joined by and or or not as in Digital Librarian see Entering Query in Chapter

Like Librarian Quotations assumes that successive words are joined by and

Quotations wont search for common words such as the and to or for words shorter

than three letters It displays quotes under their authors names authors are listed in

alphabetical order

When you search by word and enter word thats any part of an authors name other than

the last name the full name of the author is also displayed along with quotes containing

the word For example if you search by the word Sarah Quotations will find not only any

quotes containing Sarah but also Sarah Adams Mrs Sarah Josepha Hale and

Sarah 1st Duchess of Marlborough

Note When you search by word the source reference is sometimes incomplete because

the Oxford Dictionary is arranged by author and does not repeat the full reference for each

quote by the same author To see the full reference click the Word/Author button to set it

to Author select the authors name click Search locate the quote with the Find panel and

scroll up to the quote that shows the full reference
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When you want to search by author your query should be an authors last name or several

last names joined by the word or or vertical bar For example to get quotes from Jane

Austen and Emily Bronte type Austen Bronte or Austen or Bronte

All quotes are displayed under their authors names Speeches diary entries and letters are

listed in chronological order while books plays and poems are listed alphabetically by

title

If you entered several authors last names theyre listed alphabetically If several authors

have the same last name those authors are displayed in chronological order

Quotations Commands

The Quotations main menu contains the standard application commands Edit Page Layout

Print Services Hide and Quit as described in Users Reference The other commands in

the main menu are described in this section

Info

In addition to the standard Info Panel and Help commands the Info menu includes

Contents command and Preferences command described below
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Contents

The Contents command opens window for displaying introductory material from the

Oxford Dictionary The Contents window displays list of topics click topic to display

the corresponding text in the windows text area

rw ---

J-1
FIc tU use the

F-
----- .-

HOW TO USE THE DICTIONARY

The arrangement is alphabetical by the names of authors their surnames mostly

but sometimes their titles monarchs by the rimperial or royal titles writers

sometimes by their psuedonyms In general the best known names are given

andusuciflyinthefonnmostused T.S ratherthan Thomas Steams Eliot and

no Fingal OFlaherde Wifis for Oscar Sections such as the Anonymous one

Ballads the Bible the lvi ass in Latin etc are included in the alphabetical order

Under each author quotations are arranged bthe alphabetical order of the

Topic Text

Preface to the Third Edition Explains the differences between this edition and

previous editions of the Oxford Dictionary

The Compilers to the Reader Describes the initial work on the Oxford Dictionary

and how selections were made

Introduction Introduces the Oçfbrd Dictionary with commentary

on which authors are quoted the most

How to use the Dictionary Describes the organization of the Oxford Dictionary

Copyright Notice Copyright information

You can use the Find menu to locate specific text in the Contents windows text area

Preferences

The Preferences command opens panel letting you specify your personal preferences for

searches and displays Your choices remain in effect from one work session to the next
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Full Word

CPrfl

Font Size

Normally Quotations searches by Full Word It finds only words or names matching the

query exactly You may instead prefer searching by Prefix which finds all words or names

that begin with as well as match your query

The font size of the text in the text area of the main application window is normally 12

points You can change the size in which quotes found in subsequent searches will be

displayed by typing the size you want in the Font Size field and then clicking the Set button

This also determines the size of the text when its printed from Quotations

Find

The Find menu contains the standard Find menu commands as described in Users

Ref/-em -a You can use these commands to locate text in the text area of either the

Quotations application window or the Contents window whichever is the main window
The Find Panel comniand brings up the panel shown below

FifldJ

Prviôus

Quotations automatically places in the Find panel the first word of every query it searches

for immediately after the search it locates that word for you in the text area You can enter

other text in the Find panel by typing or by using the Enter Selection command or the Paste

command

The Find Next command like the Find button in the application window and the Next

button in the Find panel selects the next occurrence of the text specified in the panel the

Find Previous command or the Previous button in the panel locates the previous

occurrence The search for the text begins at the end of the current selection in the text area

or at the beginning of the current selection if Find Previous

When looking for text in the main application window Quotations continues at the

beginning of the text area when it reaches the end When searching in the Contents window

however Quotations looks through the text of all the listed topics when it reaches the end

of the current topic it looks through the next one and so on continuing at the first topic

when it reaches the last one in the list
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Part

Mail Multimedia Communication

Mail also known as NeXTmai1TM is sophisticated electronic mail application that lets you

send messages to and receive messages from other computer users on network With Mail

you can extend your workplace to include your campus or corporation as well as network

users in other states or countries And because Mail is built on UNIX mail you can use it

to communicate with other UNIX users who dont have NeXT computers If youre not on

network you can use Mail to send messages to yourself or to other users of your

computer

More than conventional mail program Mail is multimedia communication tool that lets

you share ideas and information in variety of forms with other network users.Your Mail

messages can include not only text but also graphics and even voice recordings With the

microphone built into your MegaPixel Display you can record and send voice mail to other

network users who have the ability to play back messages

Part contains two chapters

Chapter Using Mail provides an overview of the Mail application

Chapter Mail Buttons and Commands is comprehensive reference for all Mail

buttons and commands
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Chapter

Using Mail

This chapter introduces the basics of sending and receiving messages with the Mail

application The buttons and commands referred to in this chapter are described in detail in

Chapter

Messages and Mailboxes

Mail messages sent to users of NeXT computers can contain any or all of the following

Text either plain ASCII or formatted formatting means changing margins

indentation tab stops or font properties

Voice recordings and other sound recordings

Attached files or folders that you can open by double-clicking an icon

Graphics actually attached graphic files but displayed directly in message instead of

being represented by an icon

Note In fact anything other than plain ASCII text generates an attached file Formatted

text results in an attached RTF file while sound recording attaches the file containing the

recording

Messages are grouped into mailboxesfile packages with .mbox extension in

Mailboxes folder in your home folder Every user has an Active mailbox named
Active.mbox where all new messages are delivered Only your Active mailbox receives

new mail it is your starting point for most Mail operations You can also create mailboxes

for storing messages that you transfer from the Active mailbox For example instead of

letting hundreds of messages accumulate in your Active mailbox you may want to transfer

some to other mailboxes arranging them by category All your status reports could go in

one mailbox all your memos to the marketing group in another and so on
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Starting Up Mail

You can start up Mail directly from the application dock or the File Viewer in the

Workspace Manager or from within another application that has Services menu with

Mail command in it In these cases window appears that displays the contents of your

Active mailbox Mail also starts up when you open mailbox file from the Workspace

Manager window displaying that mailbox appears

If when Mail starts up you see panel that tells you the mailbox is already in use this is

Mails attempt to protect you from having the same mailbox open on more than one

computer which can cause serious problems including loss of mail Mail keeps track of

whether mailbox is open and warns you with this panel if you attempt to open that

mailbox again while its still open somewhere else This can happen in either of the

following circumstances

You log in and start up Mail on second computer To avoid problems click Cancel in

the warning panel

Your last Mail session terminated abnormally due to power failure for example
mailbox that was open then is still considered to be open during your next Mail session

Click OK in the warning panel to proceed to open the mailbox again

Note that youre more likely to start up Mail on second computer if using the Workspace

Managers Preferences command youve set up Mail to start up automatiöally when you

enter your workspace If youve set up Mail this way and you tend to log in on multiple

computers you can use Mails Preferences command to have Mail start up hidden this will

prevent the Active mailbox from being opened at all upon startup thus avoiding this

problem

Reading Messages

When you start up the Mail application window appears that displays the contents of your

Active mailbox
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Jun J. Mflh spr -e5stlanndsr

12 LawaChen Tm el

PhiI_Lpiflrandt Nw phane proredur summary area
Du d_Boumn SaIe figure

13 Lna_Ca1- cn Ne PrnInm

c---

resize knob

message area

The summary area displays one-line summaries of the messages in the mailbox Each

summary line includes message number the date the message was sent the senders

address which may also be the senders user name and the subject of the message

Icons to the left of the numbered summary lines provide additional information about

messages

indicates an unread message

indicates that the message includes formatted text graphic sound recording or an

attached file or folder You cannot forward these messages to users of computers other

than NeXT computer

If your message list is too long for the summary area use the scroller to view the additional

summaries The oldest unread message is always visible in the summary area when Mail

starts up

The message area is where you read your mail It displays the individual messages listed in

the summary area To read message click its summary line the message will be displayed

in the message area making it the current message The time and date that the message was

sent appears on the right at the top of the window If your system administrator has set up

Mail to display user pictures picture of the person who sent the message may also appear

beside the time and date
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Note Information about setting up Mail to display user pictures is available along with

other system administration information in the Network and System Administration

manual

message may include icons that represent sound recordings files or folders that the

sender attached to the message As described later you double-click these icons to play the

recording or open the attached file or folder Graphics appear directly in the message area

instead of being represented by icons Heres an example of message that contains

attachments and graphics

IThi

--

LauraC1W Trelauchers

12 Phil_LibrendP New phanprocPdure

Jun 13 DauidBoume 53le liqutes

Lane_chn Netweek ernirier
_______

Date Tue 13 Jun F-5 10 FLiT

From 3vldEnijurne

To Cvritiii_Nettle

Subject aIes figures

file

nithi attachment

Here are the sales figures you requested ________
icon

Yearly Sales

recording

icon
E- the here are some excerpts from the National Public Radio show on

--
iriicioelectronjcs that told you about LEkm3 knoi.1 what you think

our twl

-fl-- ---- 1-

To step through the list of messages in the summary area click the arrow buttons at the

upper left of the window or click lines in the summary area

If message is too long for the message area you can use the scroller to view the rest of it

You can also drag the resize knob thats located between the summary and message areas

to change the relative sizes of those areas or you can resize the entire window with the

windows resize bar
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Tip Text sent from non-NeXT computers may have Returns at the ends of lines which

might give the message ragged appearance with choppy uneven line endings To even out

the line endings widen the window with the resize bar

You cant modify message in Mails message area but you can copy text from the

message with the Copy command and paste it into another windowa WriteNow window
for examplewhere you can edit it As soon as you click in the message area the summary
line of the current message dims to light gray

Any part of message youve receivedincluding attachment icons and graphics-can be

copied into Send window the Mail window where you compose outgoing messages with

the Copy command Also Mails forwarding feature copies the entire message into Send

window where you can edit it before sending it to other users see Replying and

Forwarding later in this chapter

After reading your mail you may want to miniaturize the Active mailbox window and

return it to its original size when youre ready to read new messages or send mail When
Mail is running you can tell whether there is any new mail by the appearance of the

applications icon in the dock If there is new mail the icon shows fan of letters

otherwise it shows single letter

4_-

New mail No new mail

Tip To make Mail start up automatically when you log in use the Workspace Managers

Preferences command

Listening to Sound Recording

recording icon in message represents sound recording thats contained in the message

To listen to the recording double-click the icon to display Lip ServiceTM panel Click the

Play button in the panel to begin playing back the recording click the Stop button if you

want to end the playback before the end of the recording
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From Davii1_Eourne

VV ToCVnthla_Hettle

Subject Sa.le liqures

C.rithia

Hole are the sales Tiqures you requested

Yearly Sales

.1111111
__

IIII

11111111

the ay here are some exierpts from the National Public Radio show on

roelectroriics that told you about Lme know what you think

trulu

If the recorded message is too loud or too soft you can adjust the volume with the volume

keys on the keyboard or with the display preferences in the Preferences application

Opening Attached Files and Folders

file or folder icon in message represents an attached file or folder To open the

attachment double-click its icon

If you double-click file attachment icona WriteNow file icon for exampleit starts

up the associated application if the application isnt already running and displays the

files contents in window You can edit the contents of the file and use the applications

Save command to save the edited version if you then forward the file your saved

changes go with it If the attached file contains an application or an executable file

the application simply starts up when you double-click the icon

If you double-click folder attachment icon Mail opens Workspace Manager folder

window that displays the contents of the attached folder
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Note Double-clicking graphic starts up the application associated with the format in

which the graphic was saved

If you want your own copy of an attached file or folder you can simply drag the attachment

icon over the icon for one of your folders in the Workspace Managers File Viewer Or after

opening an attached file you can use the applications Save As command to save your own

copy You can also send copy of the attachment by dragging its icon into Send window

Since graphics are actually attached graphic files you can similarly drag them out of

mailbox window an icon representing the graphic file appears under the cursor

Deleting Message

Eventually youll want to remove some of the messages that accumulate in your mailbox

Its especially good practice to delete messages containing attachments when you no longer

need them since they can take up lot of disk space To delete message select it in the

summary area and click the Delete button or press the Delete key Use one of the selection

techniques listed in the table below to select multiple messages for deletion or for other

operations such as transferring messages to another mailbox

What You Do What Happens

Drag Selects the messages you drag across

Shift-click Adds the message or removes the message from the selection

Alternate-click Extends the selection to include all messages between the

message you click and the previously selected message

Control-clicking message selects it without displaying it in the message area This is

useful if you want to delete message without waiting to view it

Although deleted messages no longer appear in the mailbox window they arent removed

permanently until the mailbox is compacted You can compact mailbox and thus

permanently remove all deleted messages by choosing Compact from the Utilities menu

Any message deleted since the last compaction can be restored To restore the last message

or group of messages you deleted choose Undelete from the Edit menu Choose Undelete

again to restore messages from prior deletions

Sending Messages

Sending messages to other users is as easy as reading mail When you want to send

message click the Send button in mailbox window Mail will open Send window where

you can compose and address your message select mailing options and send the message

on its way After the message is sent the Send window closes You can also mail directly

from within another application if the application has Services menu that contains Mail

command as described in the NeXT Users Reference manual
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At the top of the Send window are fields in which you enter information about the message

the address of the recipient the subject of the message ASCII characters only and the

addresses of any people that you want to provide with copy of the message To send

message you must supply at least an address which is usually the user name of the intended

recipient To enter information in field click in the fieldor press the Tab key or Return

to move between fieldsand type the information

You can send message to more than one person by entering multiple addresses separated

by commas or spaces in the To field Another way to send messages to multiple users is to

enter an alias in the To field Aliases are shorthand addresses that can identify single user

or group of users when you enter an alias youre telling Mail to send the message to

everyone who has been assigned to that alias Click the Addresses button to display panel

in which you can view aliases insert aliases into Send window fields and create your own

private aliases for more information see the description of the Addresses button in Chapter

You can also enter addresses user names or aliases in the cc carbon copy field to send

copies of the message to multiple users If you want to keep copy of the message for later

reference add your own address to the cc field To keep copy of all your messages you

can use the Archive option of the Preferences command

Type the body of the message in the lower part of the Send window Use standard editing

techniques to compose and edit the message theres no need to press Return at the ends of

lines When composing message to another user of NeXT computer you can include

sound recordings in your message as described in The Lip Service Panel in Chapter

or attach files or folders see below
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The No Receipt button lets you request notification message when your message is read
and the NeXT Mail button prepares your messages for delivery to non-NeXT computer
For complete description of these buttons and the other buttons in the Send window see

Chapter

Attaching Files and Folders to Messages

powerful feature of Mail is its ability to attach files and folders including graphics to

mail messages For example if youre sending message about quarterly sales you could

attach WriteNow file containing the figures and even include pictures of the sales

representatives in the message You should only attach files and folders to messages that

youre sending to other users of NeXT computers

To attach file or folder first click where you want the attachment to appear in the message

or select part of the message that you want to replace with the attachment Then use the

Workspace Managers File Viewer or other folder window to display an icon for the file

or folder that you want to attach to the message and drag the icon into the message

If you drag an icon representing graphic file in TIFF or EPS fon at the complete

graphic contained in that file appears in the message at the insertion point or in place

of the selection

If you drag any other file icon or folder icon copy of that icon appears

etinq
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There are several other ways to attach file or folder to message in Send window You

can copy an icon or graphic from another Send window or mailbox window or copy

graphic from another application and paste it into the Send window Or you can simply

drag an icon or graphic from mailbox window into Send windowbut you cant drag

an icon or graphic Out of Send window

After you attach file or folder to message the Deliver button displays triangle to

indicate that the message should only be sent to users of NeXT computers

You can verify the origin of an attachment by holding down the Shift key and then mouse

button while the cursor is positioned over the attachment icon or graphic in the Send

window Mail displays the pathname of the file or folder until you release the mouse button

If Mail has to shorten pathname to display it it clips off the beginning of the pathname so

you can at least see the name of the file or folder that has been attached

Note You can use the same technique in the message area of mailbox window to see the

origin of an attachment in mail you receive

When you send message with attachments Mail delivers copies of the attached files or

folders the original files or folders you attached to the message remain wherever you

dragged them from

Attachments particularly graphics and sound can consume large amount of disk space

so be aware of the size of files you attach to your messages especially if youre sending the

message to multiple users In the Workspace Manager use the Inspector command in the

Tools menu to check size or display the File Viewer in Listing view

Formatting Your Messages

The Send window provides ruler that can be used to alter the format margins

indentation and tab stops of your message Mails ruler is similar to WriteNows ruler but

it has fewer features as described in this section The Text menu submenu of the Format

menu contains commands for showing the ruler and copying ruler settings as well as

commands for centering or otherwise aligning text between the margins

To display the ruler choose Show Ruler from the Text menu The ruler settings show the

format of the paragraph that contains the insertion point or the beginning of the selected

text The rulers scale is calibrated in inches The illustration below shows what the ruler

initially looks like when its displayed in Send window
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eft margin right margin
marker marker

body Indentation tab marker

marker

You can move margin indentation and tab markers by dragging them along the scale of the

ruler When you move marker in the ruler vertical gray line appears running from the

marker to the bottom of the window This line makes it easier for you to determine the

position of the marker relative to the text

There are two important things to note about the margin settings

The left and right margin settings affect the entire text thus the margin settings

whatever they may be will always be uniform throughout message

The right margin adjusts to match the width of the window If you resize the window

wider the right margin marker moves to the right and the lines of text become longer

narrowing the window moves the right margin marker to the left

Tab stops and indentation may be customized for individual paragraphs Unless you

specifically change the tab
stops

and indentation each new paragraph you type will have

the same tab stops and indentation as the preceding one If you move or copy paragraph

including the Return at the end of it the paragraph will keep its original tab stops and

indentation

If you want to change the tab stops or indentation of single paragraph you need only click

in the paragraph you dont have to select the entire paragraph After you make your

changes the paragraph is left selected When youre ready to type in the message again just

position the insertion point where you want to enter the text

When several paragraphs are selected the ruler displays the format of the first one If you

then change ruler setting the selected paragraphs will receive not only that ruler setting

but all the formatting of the first paragraph You can also copy the format of one paragraph

to other paragraphs with the Copy Ruler and Paste Ruler commands in the Text menu

Note If you copy formatted text from Mail into another application the formatting will be

copied along with the text only if the application can interpret RTF

Margins

The margin markers determine the left and right margins of the entire text To set the left or

right margin drag the corresponding margin marker to the desired position on the ruler As

you drag the left margin marker the tab and indentation markers move with it remaining

the same distance relative to the left margin

Sending Messages 133



Indentation

There are two indentation markers first-line indentation marker Twhich indents the first

line of paragraph and body indentation marker which indents all the rest of the lines

of the paragraph The two indentation markers move independently adjusting one does not

affect the other

Initially both indentation markers are aligned with the left margin marker Neither

indentation marker can be moved to the left of the left margin marker

Dragging the first-line indentation marker to the right of the body indentation marker

creates regular indentation such as the one shown in this paragraph

Dragging the first-line indentation marker to the left of the body indentation marker creates

hanging indent like the one shown here

Dragging both the first-line and the body indentation markers to the same position

indents the entire paragraph like this

Changing the left margin of the text doesnt affect indentation Both indentation markers

move with the left margin marker maintaining the same distance from it

Tabs

Tab markers set the locations of tab stopsthe positions that the insertion point will

advance to if you press the Tab key Typing proceeds normally from left to right after the

tab which lets you align columns of text vertically along the left side

Initially the ruler displays ten tab markers set eight spaces apart Note that these initial tab

markers may not line up exactly with the calibration marks on the rulers scale

To reposition tab stop drag the tab marker to the desired position on the ruler To create

new tab marker click below the scale of the ruler and the marker will appear on the ruler

above where you clicked You can remove tab marker by dragging it off the left or right

end of the ruler

Like indentation tab stops adjust accordingly when you move the left margin marker
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Replying and Forwarding

Mail provides quick ways to respond to messages or to forward copies of messages to other

users If you want to reply to specific message click that message in the summary area of

mailbox window to make it the current message then click Send to open new Send

window To automatically address your reply to the sender of the current message click the

Reply button in the Send window The To field of your message will be filled with the

address of the current messages sender or with the Reply-To address if the sender

specified one with the Options command in the Tools menu The Subject field of your

message will be filled with the current messages subject preceded by Re At the same

time the Reply button will change to Reply All

Click Reply All if you also want to send copies to everyone in the cc field of the current

message The cc field of your message will be filled with all the addresses in the cc field

of the current message and Reply All will change back to Reply The button will continue

to alternate between Reply and Reply All each time you click it

You can change or add to the addresses if you like then write your message and click

Deliver

To forward message click it in the summary area click Send and then click the Forward

button in the Send window Mail copies the current message into the message area and

enters the messages subject in the Subject field Add text before the copied message if you

like If text is already in the Send window when you click Forward the forwarded message

will be appended to the end of it You can forward several different messages adding them

one at time in this manner

Complete the forwarding by addressing the message and clicking Deliver

Creating Message History

By using Forward and Reply together you can create reply that contains copy of the

message youre responding to letting the receiver view the history of mail exchange To

include copy of the current message in reply click Forward this copies the current

message into the Send window Then type your response and click Reply or Reply All to

address it or enter addresses by typing If recipients of the message use the same

technique their replies will contain all the earlier messages in the exchange and the

message history will grow
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Chapter

Mail Buttons and Commands

This chapter describes all buttons and menu commands in Mail You should already be

familiar with the Mail concepts discussed in the previous chapter

Mail Buttons

The mailbox window buttons are described first followed by the Send window buttons

Mailbox Window Buttons

_________
Delete Send Mibe Find

Note The Find button is replaced by the New Mail button when manual retrieval of mail

has been chosen for more information see the description of Preferences command in the

Info menu under Mail Commands below

Arrows

The arrow buttons allow you to browsea message at timethrough the messages listed

in the summary area of the mailbox window The up arrow selects the message immediately

above the current message the down arrow selects the message immediately below the

current message The newly selected message is displayed in the message area

The Return key performs the same operation as the down arrow and Shift-Return performs

the same operation as the up alTow
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Delete

Clicking the Delete button deletes the message or messages selected in the summary area

of the mailbox window Pressing the Delete key or choosing the Delete command from the

Edit menu has the same effect You can reverse deletion by choosing Undelete from the

Edit menu

Messages that you delete arent actually removed from the mailbox nor is the numbering

changed until the mailbox is compacted See the description of the Compact command in

the Utilities menu

Send

The Send button opens Send window where you can compose and deliver mail message

See Send Window Buttons below

Mailboxes

The Mailboxes button displays panel that you can use to create new mailboxes open

mailboxes delete mailboxes and transfer messages between mailboxes Only your Active

mailbox actually receives delivered mail Any other mailboxes you create are for storage

and the only way mail gets into them is if you place it there yourself The special Outgoing

mailbox which can be used for automatic filing of all your outgoing messages is an

exception see the description of Preferences in the Info menu for more information
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The Delete button in the Mailboxes panel lets you delete one of your mailboxes from the

file system thus deleting all messages in the mailbox To delete mailbox select it from

the list displayed in the panel then click Delete If you delete the Active mailbox all its

messages will be destroyed another empty Active mailbox will be created the next time

you start up Mail

The New button lets you create additional mailboxes for storing and managing your mail

messages To create new mailbox type mailbox name in the Name field Mail adds the

.mbox extension for you and then click New Mail opens mailbox window for the new

mailbox which is initially empty to add messages to it copy messages from other

mailboxes or transfer them from other mailboxes using the Transfer button

Tip No two mailboxes can have the same name but if you want to create mailbox with

name similar to that of an existing mailbox select the mailbox to display its name in the

Name field then edit the name as soon as you change the contents of the Name field the

New button becomes available for creating the new mailbox

UtJfl

The Open button in the Mailboxes panel opens selected mailbox and displays its contents

in mailbox window To open mailbox select it from the list displayed in the panel and

then click Open or simply double-click the mailbox in the list Mail opens mailbox

window that lists all the messages currently stored in that mailbox The name of the mailbox

appears in the title bar of the window You can also open mailbox by opening the

corresponding mailbox file from the Workspace Manager
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The Transfer button moves messages between mailboxes To transfer mail messages select

the messages you want to move in mailbox window and click Mailboxes in the Mailboxes

panel select destination mailbox from the displayed list and click Transfer to move the

messages to the new mailbox You dont have to open mailbox to transfer messages into it

Find

Ii
The Find button has the same effect as the Find Panel command in the Find menu See the

description of the Find command in the Edit menu

Send Window Buttons

___ ___ ___ ___ ___ ___ fl
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Deliver
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The Deliver button sends the message currently displayed in the Send window to the users

specified in the To and cc fields and in the bcc field which you can fill using the

Options command in the Tools menu triangle appears in the button as shown above

when the message in the Send window includes formatted text graphic sound

recording or an attached file or folder the triangle reminds you not to send the message to

users of computers other than NeXT computer also see NeXT Mail or Non-NeXT

below
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Lip Service

The Lip Service button displays panel that you can use to create sound recordings with

the built-in microphone located on the bottom edge of your monitor to the left of the NeXT

logo If you dont have built-in microphone you can plug one into the microphone jack

on the back of the monitor After creating sound recording in this panel you can include

the recording in your mail messages See The Lip Service Panel below

Addresses

The Addresses button displays panel in which you can view the addresses of other users

on the network You can also select addresses and put them directly into the To and cc
fields of the Send window and define aliases custom addresses for your own personal use

See The Addresses Panel below

Reply or Reply All

tfM

This button lets you quickly reply to the current message The button alternates between

Reply and Reply All as you click it inserting the appropriate information in the Send fields

the current message is used as source

When you click Reply the To field of the Send window is filled with the address of the

current messages sender or with the Reply-To address if the sender specified one with the

Options command in the Tools menu the Subject field is filled with the current messages

subject preceded by Re At the same time the Reply button changes to Reply All

Reply All is useful if you want to send copy of the reply to all the users who received the

original or copy of the current message In addition to filling in the To and Subject fields

of the Send window Reply All fills the cc field of the Send window with the addresses
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that appear in both the To and the cc fields of the current message Addressees in the

bcc field of the original message if any will not receive your message

Tip If you want your reply to include copy of the current message first click Forward

to copy the message into the Send window then type your response and click Reply or

Reply All to fill the appropriate fields for delivery

Forward

IIi
i_11I

The Forward button lets you quickly forward the current message to other users When you

click Forward Mail copies the current message into the Send window following any text

thats already there and enters the subject of the message in the Subject field The copy of

the current message in the Send window is preceded by additional information about that

message including the date it was received the address of the original sender and the

address of the original recipient or recipients

No Receipt or Receipt

When you click No Receipt the button changes to Receipt indicating that youll be sent

notification when your message has been read by each NeXT recipient including To cc
and bcc The notification mail generated by the system will be delivered to your Active

mailbox showing the subject line of the message and the time and date the message was

read Clicking Receipt changes the button back to No Receipt

NeXT Mail or Non-NeXT

This button makes it easier to compose and edit messages youre sending to users of

computers other than NeXT computer The button alternates between NeXT Mail and

Non-NeXT as you click it
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When you click NeXT Mail the button changes to Non-NeXT and your message is

prepared for delivery to non-NeXT computer The text of the message changes to ASCII

characters as described below and Courier font formatting is lost and the line length is

limited to no more than 72 characters This ensures that what you see on your screen will

closely resemble what the recipient will see Word wrap continues to work as usual only at

the moment of sending will Return characters be added to the ends of lines as required by

the receiving computer

If there are any attachments in your message panel appears reminding you to remove

these before Non-NeXT can go into effect Remove the attachments then click the NeXT

Mail button again

The character set is restricted to ASCII when communicating with non-NeXT computers

because the standard UNIX mail mechanism underlying Mail which Mail uses in

communicating with non-NeXT computers does not recognize characters outside the

ASCII character set and will convert any such characters to ASCII An em dash for

example would be converted to the letter See Appendix of Users Reference for

more information on the ASCII character set

If you dont use this button to specify non-NeXT mail the recipient may have difficulty

reading your message because lines may break in the middle of words Formatting or

attachments will generate unintelligible messages on non-NeXT computers

If you click Non-NeXT when theres already message in the Send window the message
remains plain ASCII characters unformatted but its font becomes 12-point Helvetica

Medium unless you changed the initial font as described under the Font command

The Lip Service Panel

When you click the Lip Service button in Send window or double-click recording icon

in mailbox window or Send window Mail displays the Lip Service panel where you

can create and edit sound recordings for insertion into your messages or listen to recording

attached to message

The Lip Service panel displays meter that indicates the sound level for the recording

youre currently creating or playing back For example
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The Edit button displays graphic of waveform that represents the current recording The
button is highlighted while waveform graphic is displayed You can select segments of

the waveform by dragging across it and use the standard editing commands Cut Copy and

Paste on the waveform to modify the recording The waveform graphic does not track the

progress of recording while its being played back but by selecting segments of the

graphic and playing them you can locate precise points for editing You can also resize the

Lip Service panel to adjust your view of the waveform For example

1b ./LJt
-J

Wi .1

1iiF ei EreL

If no recording is available for editing the waveform area is empty Click the Edit button

again to remove the waveform graphic from the panel

The Stop button stops the recording youre currently creating or playing back

The Play button plays back the current recordingeither the recording you made in the Lip

Service panel or the recording associated with the recording icon in the current message

Click Stop to end the playback before the end of the recording

If segment of the waveform is selected when you click Play only the part of the recording

represented by the selected segment is played otherwise the entire recording is played

If the recording is too loud or too soft you can adjust the volume with the volume keys or

the Preferences application

Pà.ue

The Pause button halts the recording youre currently creating or playing back The bars

on the button are highlighted during pause Click Pause again to restart at the point where

you paused
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The Record button starts recording through the microphone built into your Megapixel

Display or microphone connected to the microphone jack on the back of the MegaPixel

Display If you want to stop the recording before its finished click Stop Clicking Play

also stops the recording

To replace segment of the waveform with something new select the part you want to

replace then click Record and record the new material the new recording will replace the

selected segment of the current recording To insert new material in the recording without

changing the old click at the point in the waveform where you want to insert the new

material an insertion point appears then click Record and record the new material You
can also use Cut Copy and Paste to edit the waveform

The Erase button erases the current recording It erases the entire recording even if

segment of the waveform is selected when you click Erase

The Insert button includes the current recording as part of the message in the Send window

then closes the Lip Service panel recording icon appears at the location of the

insertion point or replaces the current selection in the Send window to indicate that the

sound recording is inserted in the message

When you deliver the message recipient can listen to the recording by double-clicking

the recording icon

The Insert button is dimmed if theres no current recording If you click Insert when no

Send window is open panel will appear telling you that Mail cant complete the operation

If you click the close button Mail does not include the recording in the message but saves

it as the current recordingwhich you can modify or insert later on Regardless of whether

you clicked Insert or the close button the current recording remains available until you

replace it with new recording so you can click Lip Service again to display the Lip

Service panel and include the recording in another message

The Addresses Panel

When you click the Addresses button in Send window Mail displays the Addresses panel

which has several uses It stores addresses like an address book it lets you insert addresses
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in address fields without typing and so without typing errors and it can be used to create

new Mail aliases custom addresses for your personal use

ame

prnu dii Fintl

The Addresses panel uses browser to display addresses Select from this browser just as

you would select folders and files in File Viewers browser either by clicking or by

typing

Five address types appear in the first column of the browser The Users Groups and Login

Names addresses are defined by your system administrator The Private Users and Private

Groups consist of addresses that you add yourself They can be existing addresses or aliases

that you create there will be none of these until you begin adding them as described under

Private Aliases below

When you select an address your selection appears in the Name field You can also type

path to an address in the Name field as you would type the pathname to folder or file in

Workspace Manager Finder panel

The panel also displays the pictures of individual users if available For Private Users and

Private Groups the panel displays silhouette icons to represent single users or groups of

users

Hc
Use this button to search for an address based on text that appears anywhere within the list

full name or part of name will work For example if you type peters in the Name field

and click Find Mail can locate and select an addresses such as Dave Peterson or rpeters

Click Find again to find the next instance of the text in the list
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The cc button appends the address that appears in the Name field to the cc field in the

Send window Similarly the To button appends the selected address to the To field in the

Send window When Mail appends an address to the list in Send window field it

automatically separates the entries with commas These buttons never replace text in the

Send window fields selected or notthey only add to the list in field

Private Aliases

You can use the Addresses panel to create and manage your own lists of addresses For

example you could have selected list of people to inform of company softball games The

advantage of private alias over one defined by your system administrator is that you have

complete control over the alias

Mail lets you maintain two types of lists Private Users for storing commonly used

addresses user names or aliases and Private Groups for creating group aliases

The Private Users list provides the equivalent of an address bookyou can quickly find the

address you want without having to search through long lists For example if you

frequently send messages to long address such as baines@pucc.princeton.edu you can

add the address to your Private Users list where you can quickly locate it and append it to

Send window address field

The Private Groups list provides an area for creating personal aliases for single or multiple

network addresses For example you could create the shorthand alias nr for the existing

address nross or you could create the alias art for every user in the art department When

creating personal aliases follow the conventions for naming files as described in Users

Reference except dont use comma or space After you create Private Groups alias

you can insert the same alias in your Private Users list

Remember Private Groups aliases are for your personal use only Other users on the

network cannot send mail to an alias you create in the Addresses panel unless they too

create that alias for their own use

The Remove button is available only when the Private Users type or Private Groups entry

is selected in the browser This button removes the selected entry unless its the only address

associated with private group You can remove this address after adding another address

to the group or remove the single-address group itself

The Add button is available only when the Private Users type or Private Groups entry is

selected in the browser This button adds the address entered in the Name field to the

selected list
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To add new address to the Private Users list select Private Users in the Types column

enter the address in the Name field and click Add Mail displays the new entry in the

Private Users column You can also use the Add Private User command in the Utilities

menu to add addresses to the Private Users list

To create new group alias select Private Groups in the Types column enter an alias in the

Name field and click Add Mail displays the new alias in the Private Groups column The

alias automatically includes your own mail address after you add more addresses you can

select this address and remove it To add to private group select the groups alias in the

Private Groups column enter an existing address user name or alias in the Name field and

click Add Mail displays the entry in the browser column to the right of the Private Groups

column You can add as many addresses as you want to Private Groups alias

If you try to create Private Groups alias thats identical to an existing network alias Mail

will inform you that the alias already exists and will refuse to accept it

Mail Commands

Mails main menu contains the standard Windows Print Services Hide and Quit

comrnands as described in Users Reference The other commands in the main menu and

commands in their submenus are described below

Info

In addition to the standard Info Panel and Help commands the Info menu contains

Preferences command
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Preferences

The Preferences command opens panel that lets you set your personal preferences for

various aspects of Mails delivery system and your own outgoing mail There are two

groups of preferences Normal and Expert The group currently being displayed in the

Preferences panel is indicated by the button at the top of the panel To change to the other

group press the button and choose it from the list

Normal

After selecting the preferences you want click OK If you change your mind before

clicking OK click Revert to see what the settings were when you opened the panel or last

clicked OK

Noniial Preferences
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Normal

Ne lail Petuevdl

Matitial

Automatic

A1to-â1inc --

jHide orLAuto-L8uFich

SendOptions

Read Receipt

._J Noh-NeXT Mail

jjrchive

Include Self in Grnup

Net Mail Retrieval --

Manual

utrirntlc

The Manual and Automatic buttons control the method Mail uses to retrieve new mail

Since mail messages go to central post office Mail must periodically inquire whether

anything has been delivered if you have mail its retrieved from the central location and

deposited in your Active mailbox The normal method of retrieval is Automatic which

means that Mail will automatically retrieve new mail whenever it finds any during its
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periodic check If you choose Manual the retrieval of new mail will occur only when you

initiate it yourself by using the New Mail command in the Utilities menu or the mailbox

windows New Mail button which appears in place of the Find button when manual

retrieval has been chosen Manual retrieval may be desirable if network time is costly

.... Query lntenf

FMIfl8SL

Normally Mail checks for new mail every five minutes You can change this interval by

specifying different number of minutes in the Query Interval field Some people increase

the interval because they prefer seeing letters fanning in the Mail icon less often

uto-Lauth

jHide on Puto-Launch

It this box is checked and youve used the Workspace Managers Preferences command to

have Mail start up automatically when you enter your workspace Mail will start up hidden

The Active mailbox wont be opened as described in Chapter under Starting Up Mail
this is useful if you tend to log in on multiple computers

Send Optlorlb

JRetd Receipt

JNon NeT Mail

jArchw
tncude SIfui Groups

Read Receipt corresponds to the No Receipt or Receipt button in the Send window If this

box is checked all your Send windows will open in Receipt mode

Non-NeXT Mail corresponds to the NeXT Mail or Non-NeXT button in the Send window

If this box is checked all your Send windows will open in Non-NeXT mode

If Archive is checked copies of all your outgoing messages will be sent to mailbox named

Outgoing which is created automatically

Include Self in Groups which is normally checked means that when you send mail to

group alias that includes your user name youll receive the mail Click this box to remove

the check mark if you dont want to receive mail that you send to these groups
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Expert Preferences

Cs

cm urn ii

..tiriIib/endui.niI

Expert preferences include advanced text editing features and system modifications that

will primarily be of interest to expert UNIX users or system administrators

iuto ludantatiort

Puto Indent Oft

utolnrjenton

Autoindentation pleser\es the indentation of the previous line when you type Return If

you indent line with tab the next line will automatically tab to the same spot when you

PICSS
Return If you indent line with spaces tabs will be inserted in the next line first

followed by as many spaces as may be needed Auto-indentation is most useful for entering

text iii the Courier font family for example for programmers entering code

Emcs Ke Bindinjs

Ve BindinçJ Oil

Ke Bindings On

This is an advanced feature for users ho are accustomed to traditional terminalbased

editors Emacs is popular text editor used by UNIX programmers Key bindings refers

to the attachment of commands to keys For example with Emacs Key Bindings switched
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on Control-F moves the insertion point forward one character The Emacs commands that

operate in this mode are as follows

Command Action

Control-B Move back one character

Control-F Move forward one character

Alternate-b Move back one word

Alternate-f Move forward one word

Control-A Move to beginning of line

Control-E Move to end of line

Control-D Delete next character

Control-H Delete previous character

Alternate-d Delete to end of current or next word

Alternate-h Delete to beginning of current or previous word

Control-K Delete forward to end of line

Alternate- Move to beginning of text

Alternate- Move to end of text

Control-N Move down one line

Control-P Move up one line

_________
fusrpuob mail

E1 ______

The Administration preferences are primarily for system administrators

The Mail Dir field specifies the directory in which your Active mailbox and other mailboxes

are stored If you have an optical disk for example changing this directory to one located

on your optical disk would allow you to store your mail there

The Spool Dir field specifies the directory from which Mail retrieves new mail If the

volume of mail is high changing this directory makes it possible to reduce the number of

eople reading mail from the same directory Any change should be made by your system

administrator

The Mailer field specifies the program that Mail uses to send mail You can change this

programfor example to one that keeps track of mail statistics This feature is for system

administrators only For more information about the default mailer program see the UNIX
manual page for sendmail UNIX manual pages are available on-line only in the extended

release of the software
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Edit

Cut Copy Paste and Delete

These are the standard editing commands described in Users Reference The effects of

these commands depend on what type of window is the key window

In mailbox window the Cut Paste and Delete commands apply to the message or

messages selected in the summary area The Delete command thus works the same as

the windows Delete button The Copy command can be used either to copy selected

messages or to copy selection in the message area whichever you selected last

Copied text can be pasted into any window that accepts text copied icons and graphics

can be pasted into Send window

In Send window Cut Copy Paste and Delete work within the message and in the text

fields

In the waveform that appears when you click the Edit button in Lip Service panel you

can use these commands to modify the sound recording

In panels you can use these commands to edit text in text fields

Undo

The Undo command reverses the last deletion performed in the message area of Send

window Repeated use of the command inserts copies of the last deleted selection Undo

does not reverse any other editing operations
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Unclelete

The Undelete command reverses the last message deletion you performed unless the

mailbox has been compacted since you deleted the message Subsequent Undelete

commands will restore previous message deletions up to the point that the mailbox was last

compacted The undeleted messages are displayed in the summary area when you use the

command

Note Undelete does not reverse any other type of deletion such as deletion of text from

Send window for that use Undo

Find

Find teL
FihdN

FievioUs

EritrSØlctiOi

The Find menu contains commands that are very similar to those in the standard Find menu
described in Users Reference Information specific to Mails Find menu commands is

presented here

The exact appearance of the panel displayed by the Find Panel command depends on

whether youre searching for messages in the summary area of mailbox window or for

text in message that appears in mailbox window or Send window When you search

for messages the panel looks like this

tIOors

PP3ce Ff Frevious Ne

The All Scope buttons are available only when replacing text in message in Send

window as described below The Find Options check boxes apply in any case
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If Ignore Case is checked Mail doesnt distinguish between capital and lowercase letters

during the search If Ignore Case is not checked Mail searches only for the text that exactly

matches the capital and lowercase characters you specify

If Regular Expression is checked Mail allows you to use regular expressions as defined in

UNIX text editors for finding character strings in message summary or message This

option is implemented primarily for expert UNIX users see the UNIX manual page for ed

for more information on regular expressions UNIX manual pages are available on-line

only in the extended release of software

Finding Messages

To find mail messages click in the summary area of mailbox window and choose Find

Panel from the Find menu or click the Find button in the mailbox window to display the

Find panel In the Find field enter the text that you want to locate in message summary
You can enter characters that may appear anywhere in message number date senders

address or subject

Click one of the buttons in the Find panel to perform the operation you want Found

messages are selected in the summary area message informs you if the text youre

searching for isnt found You can view the text of found message and make it the current

message by clicking its summary line

____
Click Find All to select all the message summaries that contain the text specified in the Find

field

.iuxii ui
Click Previous to search backward from the message or group of messages selected in the

summary area Click Next to search forward The search is circular If the search is moving

backward through the list of messages and reaches the beginning of the list without finding

anything it continues at the end of the list if the search is moving forward and reaches the

end of the list it continues at the beginning
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Finding Text in Messages

To find text in messages click in the message area of mailbox window or make Send

window the key window and choose Find Panel from the Find menu or click the Find

button in the mailbox window to display the Find panel In the Find field enter the text you

want to locate Find will not search for text in attached files

trscope Find Optwns

EtThr Ffl- LlInore CaE

pldepced1 reviou4 ui
Click one of the buttons in the Find panel to perform the operation you want The All

Scope Replace All Replace and Replace Find buttons are dimmed for mailbox

windows Found text is selected and displayed in the Mail window message informs you

if the text youre searching for isnt found

IIIScope
EntirFil

____
The All Scope buttons indicate the area that Replace All will apply toeither to the entire

message in the Send window Entire Fileor only to the text thats currently selected in the

message Selection In the indicated area Replace All replaces all occurrences of the text

specified in the Find field with the text specified in the Replace with field If the Replace

with field is blank Replace All deletes all occurrences of the text

Replace

Once text has been found in the Send window click Replace if you want to replace that

occurrence with text specified in the Replace with field or if the Replace with field is

blank and you want to delete that occurrence

i.cHniif

As shortcut you can click this button to combine the Replace and Next operations Mail

will replace or delete the found text and then find the next occurrence
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Click Previous to search backward from the insertion point or from the beginning of the

current selection If the search reaches the beginning of the text it continues at the end

J1
Click Next to search forward from the insertion point or from the end of the current

selection If the search reaches the end of the text it continues at the beginning

Spelling

The Spelling command is available oniy in Send window and only for text in the message

itself not in an attached file It brings up panel that lets you check the spelling of words

in your message choose from possible corrections and modify the spelling dictionary As

convenience Mail doesnt bring up the Spelling panel as the key window so that you can

type to correct misspelling without having to click in the Send window first

To begin spelling check from this panel click Find Next Spelling locates and selects the

next word not contained in the spelling dictionary Mail uses system-wide 100000-word

spelling dictionary thats shared by other applications such as Edit

Note Word processing applications like WriteNow tend to use their own dictionaries

rather than this system-wide one

The search for misspelled words is circular so that the entire text of the message in the Send

window is searched The search starts at the word containing the insertion point or at the

last word in the current selection and goes to the end of the text If no potentially misspelled

words are found the search continues at the beginning of the Send window until it comes

back to the starting point

The Spelling panel displays list of possible corrections to the last word selected as

misspelled unless the word is completely unrecognizable Double-clicking one of them

will replace the selected word in the Send window with the desired correction

jWail Comniancls 157



The Learn and Forget buttons let you remove or add words from the spelling dictionary If

correctly spelled word is identified as misspelled you can add it to the dictionary by

clicking Learn You can also remove any word youve added to the dictionary by selecting

it and clicking Forget

To search for the next misspelled word click Find Next or choose the Check Spelling

command from the menu

Check Spelling

Choosing the Check Spelling command has the same effect as clicking Find Next in the

Spelling panel see the Spelling command above Spelling locates and selects the next

word not contained in the spelling dictionary To replace the misspelled word you can just

begin typing

For more options when checking spelling use the Spelling command either after Check

Spelling or instead of Check Spelling

Select All

The Select All command selects the entire contents of the last area you clicked in whether

the summary area of mailbox window message in mailbox window or Send window
text field in Send window or panel or waveform in Lip Service panel

Format

The Format menu contains the Font and Text commands described below and the standard

Page Layout command described in Users Reference
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Font

Fhtpnej

Lite
Suprcript

Subrijif

IJrtsbrit

LightGra

arkaV
8atk

Copy Font

astdæt .4

The Font menu contains the standard Font menu commands for changing the appearance of

characters plus the Light Gray Dark Gray and Black commands These three additional

commands change the shade of text which is normally Black they can be used to highlight

words in messages for emphasis or to mark related passages The font in Mails windows

is initially 12-point Helvetica Medium unless you change this initial font as described

below

The effect of command in Mails Font menu depends on which window is the key window

when you choose the command and in the case of mailbox windows which area of the

window you last clicked in

In Send window the Font menu commands affect text selected in the message You

can apply different font properties to individual characters or words in message The

Underline Superscript Subscript Unscript Light Gray Dark Gray and Black

commands are available only in Send windows

In mailbox window the Font menu commands affect all the text in the summary area

or the message area of the window whichever area you clicked in last You can set

different font in each of the two areas Mail uses the new font in every subsequent

mailbox window that you open until you change it again with the Font menu
commands The font set in the message area is also used in every subsequent Send

window that you open
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Font properties copied with the Copy Font command do not include Underline Superscript

Subscript Light Gray Dark Gray or Black

Text

The Text menu contains commands for formatting the text of your message in Send

window For related information on how to set margins indentations and tab stops with the

ruler see Formatting Your Messages in Chapter

Align Left Center and Align Right

These commands align the text with the left margin ragged right center it between both

margins or align it with the right margin ragged left

Show Ruler or Hide Ruler

Show Ruler displays the Mails ruler in the Send windows message area and the Hide

Ruler command removes it

Copy Ruler and Paste Ruler

The Copy Ruler command copies the ruler settings of the paragraph containing the insertion

point or the beginning of the current selection so that you can subsequently paste them with

the Paste Ruler command Its as though theres separate pasteboard for the ruler and

Copy Ruler replaces whats already on it just as the Copy command does for text

The Paste Ruler affects the paragraph containing the insertion point or the current selection

It replaces the paragraphs ruler settings with the last ones you copied with the Copy Ruler

command If the current selection spans more than one paragraph Paste Ruler replaces the

ruler settings of all the selected paragraphs
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Neither of these commands requires the ruler to be showing or changes the contents of the

pasteboard

Tools

The first four commands in the Tools menu provide alternative ways of opening the

Addresses panel Lip Service panel Mailboxes panel and Send window The Options
command is described below

Options

You can use the Options command when youre working in Send window it brings up

panel containing large area for entering address lists You can resize the panel for an even

larger area The button at the top of the panel specifies the type of address field To change

it press the button and drag to the type of field you want

-z-
After entering the addresses of the specified type exactly as you would in Send window
click OK

The To option corresponds to the To field in the Send window Any addresses you enter will

be inserted in the Send windows To field when you click OK
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The cc option corresponds to the cc field in the Send window Any addresses you enter

will be inserted in the Send windows cc field when you click OK

The bcc blind carbon copy option is for confidential or hidden addressees of your

message Whoever you enter here will receive copy of the message but no other recipients

will know since the bcc list does not appear in the message thats received

Use the Reply-To option when you want the reply to your message to go to someone other

than yourself The address entered here will be inserted in the To field of the recipients

Send window when the recipient clicks Reply For example if youre sending memo to

Purchasing but you want Purchasing to reply to Personnel you would enter Personnels

address in the Reply-To field When Purchasing clicks their Reply button the To field of

their message will be filled with Personnels address If you also want reply append your

address in the Reply-To field

Utilities

II11FIi

Sort by Date Sort by Name Sort by Number and Sort by Subject

Normally Mail lists and numbers mail messages in the order in which they were received

by the mailbox You can use the Sort commands to reorder the messages

Sort by Date sorts the messages in the order in which they were sent which may differ

from the order in which they were received

Sort by Name sorts the messages by the address of the sender in ASCII order

alphabetical but with capital letters preceding lowercase for more information see

Users Reference
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Sort by Number sorts the messages sequentially by message number which is also the

order in which they were received by the mailbox

Sort by Subject sorts messages by their subject titles subject titles are in the last

column of the summary area This is helpful for collecting messages on single topic

or for gathering them together for deleting or moving to other mailboxes

Regardless of the specified sort order each new message is numbered sequentially in the

order in which it is received

Sort orders are temporary if you close mailbox window after specifying sort order and

then reopen the mailbox the messages will appear sorted by message number

Compact

The Compact command compacts mailbox by removing from the file system all the

messages that youve deleted since the last compaction When you compact mailbox Mail

renumbers the remaining message-s to fill any gaps left in the numbering sequence by the

message deletions

Warning Make sure that you want to permanently remove deleted messages when you compact
mailbox Compact cant be undone

New Mail

The New Mail command retrieves new mail immediately and deposits it in your Active

mailbox Normally Mail retrieves mail whenever it finds any during its periodic check for

new mail you might use New Mail if youre in hurry to read mail that you know has been

sent but you havent yet received If youve used the Preferences command to turn off

automatic mail retrieval youll receive mail only when you choose New Mail

Acid Private User

The Add Private User command adds the senders address from the current message to the

Private Users list in the Addresses panel After you add an address to the list you can use

the Addresses panel to append the address to Send window fields which cuts your typing

time and the chance of typing errors See The Addresses Panel in the Mail Buttons

section above
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Make ASCII

The Make ASCII command converts the message in the Send window to plain ASCII text

removing all formatting from it and converting non-ASCII characters into ASCII

characters If the message contains any attachments panel appears saying that you must

remove all attachments before the command can be carried out dismiss the panel remove

ail attachments and then choose the command again

Since theres some overhead associated with sending mail thats formatted and includes

attachments you might use Make ASCII if for example youre forwarding heavily

formatted message to another NeXT computer user but want to keep it simple and fast

Unlike the NeXT Mail button in the Send window this command doesnt enforce

72-character line length change the text to Courier or add Returns to the ends of lines when

you send the text Use the NeXT Mail button rather than the Make ASCII command when

you want to send mail to non-NeXT computer
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Appendices

These appendices provide specialized information about WriteNow

Appendix provides details about converting other types of files to WriteNow and vice

versa and about transferring WriteNow documents from an Apple Macintosh to

NeXT computer

Appendix summarizes useful features of WriteNow that arent available as

commands in menus or that require pressing special key
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Appendix

Document Conversion in WriteNow

This appendix provides details about converting various types of files to WriteNow and vice

versa and about transferring WriteNow documents from an Apple Macintosh to NeXT

computer

As described under Open and Save and Save As in Chapter you can convert other

types of files to WriteNow and you can save WriteNow documents as other file types Many

applications including WriteNow Edit Microsoft Word and Microsoft Write use

standard file type known as Rich Text Format RTF to convert other document formats to

their own format RTF which was developed by Microsoft Corporation serves as an

intermediate step in the conversion process document saved as an RTF file in one

application can be opened in another application that recognizes RTF and thus converted

to the other applications format But not all document features can be converted correctly

because RTF cant represent all possible document characteristics and because different

word processors often interpret similarfeatures in different ways or have entirely different

features

Note Files called filters located in WriteNows file package are required for converting

between WriteNow and RTF

When WriteNow documents are transferred from Macintosh to NeXT computer not all

document features are retained this appendix lists the unretained features

Opening an RTF File

The following features are ignored when an RTF file is opened in WriteNow since

WriteNow doesnt support them

Style sheets

Color tables

Custom footnote separators

Top and bottom margins

Widow control

Line numbers

Section breaks

Restarting page numbers

Vertical alignment

Paragraph borders
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These RTF features arent converted exactly

Double Underline text is displayed as underlined text Outline and Shadow text is

displayed as bold text But WriteNow internally stores the use of Outline and Shadow

so the text might be displayed properly when the file is opened in another application

Strikethrough and Hidden text is converted to the medium-weight typeface for the font

family such as Times Roman or Helvetica Medium

Paragraph line spacing may be different

Side-by-side paragraphs appear in single-column format

Footnotes never appear at the end of the document theyre always at the bottom of the

appropriate page and column

Headers or footers defined to be on the first page only are inserted at the beginning of

the WriteNow document

Page dimensions are set as specified in the Page Layout panel rather than as specified

by the RTF file

Left and right margins in WriteNow are the sum of the left and right margins and the

left and right indents defined in the RTF file

Since WriteNow doesnt support section breaks the number of columns in the first

section applies to the entire document

Microsoft Windows metafiles and bitmaps are not converted

Characters other than ASCII characters might not be displayed correctly because

different computers support different character sets You can reenter the correct

characters by typing them in see the Character Sets appendix of the NeXT Users

Reference manual for information

Saving an RTF File

The features that arent converted exactly from WriteNow to RTF are as follows

If more than one header or footer is defined in single paragraph in WriteNow only

the first one is converted

The smallest left or right margin in the WriteNow document is converted to the left or

right margin in RTF The difference between given paragraphs margins and the

smallest left or right margin becomes the left or right indent
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Transferring WriteNow Document from Macintosh

To transfer WriteNow document from Macintosh to NeXT computer move the

document as is do straight binary transfer since the document is already in WriteNow

format Either before or after the transfer give the document .wn extension You can

open the document in WriteNow on NeXT computer just as you can open any other

WriteNow document

Not all features of the transferred document are retained on NeXT computer The

Macintosh QuickDraw graphics format is incompatible with the NeXT computers EPS

graphics format so graphics are shown as gray boxes Also Outline and Shadow text are

displayed as bold text

Note If you move the transferred document back to the Macintosh some characters will

be translated incorrectly but the original graphics will be redisplayed Text that was

originally in Outline or Shadow style will also be redisplayed because the transferred

document internally stores the texts original style
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Appendix

Special Features of WriteNow

This appendix summarizes useful features of WriteNow that arent available as commands

in menus or that require pressing special key

Context Feature How to Do It

Insertion point Move left or right one word Shift left or right arrow key

Move up or down one line Shift up or down arrow key

Move to edge of window Control arrow key

Graphics after Scale and retain proportions Drag

double-clicking Scale to any proportions Alternate-drag

Return to original size Shift-click

Ruler general Relative settings Command ruler change

Identical settings Shift ruler change

Tabs Tab fill leader Hold down Tab type tab fill

character release Tab

Align with any character Right tab soft hyphen Insert Soft

Hyphen command after character

Document Use customized new document Document named Stationery.wn in

operations your home folder

Override Stationery.wn Alternate New
Close all documents Alternate Close document

or Alternate-click its close button

Save compactly Alternate Save or Alternate Save As

Page Layout smart Override quote conversion Type Command- for and
quotes Command- for

Font operations Identical font properties Shift font change

Superscript or subscript one pixel Alternate Superscript or Subscript

Hide or Show Space Keyboard alternative Command-space

Spelling Start over with no words ignored Alternate Ignore

continued
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Context Feature How to Do It

Find panel Search for Tab Type Alternate-Tab \T or\t

Find field Search for Return or page break Type Alternate-Return \R or \r

Search for any character Type question mark

Search for question mark Type

Search for text \T Type \\T

likewise for \t \R or
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Glossary

absolute pathname

pathname that starts with the root folder represented by slash and ends with the file

or folder that the pathname identifies

alias

shorthand address used in the Mail application to identify single user or group of

users

application

program with graphical user interface that you can run from the workspace such as

WriteNow Digital Webster or Preferences

application dock

The column of up to 13 icons along the right edge of the screen also called the dock It

contains application icons that you can use to start up applications it can also contain the

recycler

arrow keys

Four keys labeled with arrows that cause movement usually of the insertion point in the

indicated direction

ASCII characters

subset of the characters that can be typed from the NeXT keyboard as shown in the

Character Sets appendix of the NeXT Users Reference manual

attention panel

panel that requires you to perform an action in it before you can continue to work in an

application It cant be covered by any other window or icon

binding margins

Margins on the left and right sides of page set with WriteNows Page Layout command
that are used to reserve space for binding printed documents or to set up margins in

multiple-column document

body

The area of WriteNow page that contains all text and graphics that arent in headers

footers or footnotes All the typing and editing you do in page view is in the body of the

page
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bookshelf

collection of targets
in digital library in which Digital Librarian searches the

targets

you select

brightness keys

The two keys that control the brightness of the screen The upper key increases the

brightness the lower key decreases it

browser

multiple-column area of window in which you can browse through hierarchically

organized information by clicking names in the columns The File Viewer for example

includes browser with file and folder names in it for navigating the file system

jL

control that you click to make something happen or press to cause continuous action

Buttons are labeled with text graphics or both

byte

unit of information in the computer In plain ASCII file for example each character

occupies one byte

close

To make window disappear from the workspace when youre done using it Closing

window that contains file puts the file away usually giving you chance to save changes

first

close button

control in windows title bar that when clicked closes the window When the close

button is partially drawn it means that the window contains unsaved changes or that its

contents arent up-to-date

command

word or phrase in menu that describes an action an application can take or names

submenu or panel it can open

cpntrol

graphic object in window that you operate to make something happen button text

field slider or scroller

current document

The document in WriteNows main window

current folder

The folder that youre currently working in If youre working in file the current folder is

the one containing that file In File Viewer window the current folder is the one displayed

in the icon path if folder is selected if file is selected or if more than one file or folder

is selected the current folder is the one containing the selection
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current font

The font of either the text youre about to type at the insertion point or the first character in

the current text selection

current message

The message that culTently appears in the message area of mailbox window in the Mail

application You make message the current message by clicking its summary line in the

summary area of the window

cursor

The image on the screen that moves as you move the mouse usually an arrow or an I-beam

When the computer is performing an operation that must be completed before you can

continue your work in that application the cursor appears as rotating disk

data document

document from which WriteNows Merge command will read records of information to

be merged into the template document

data record

In data document read by WriteNows Merge command record that contains value for

each field defined in the names record Each data record results in merged document

default headei default footer

The blank header or footer in new WriteNow document consisting of four blank lines

You can override the default header or footer by inserting one of your own

Delete key

key used to remove individual characters words graphics or other items Its labeled

Delete on older keyboards

detach

To drag submenu away from its associated menu

digital library

An on-line collection of informationincluding for example reference works

documentation and literaturethat can easily be accessed with NeXT application

designed for that purpose

dimmed

Gray faded or otherwise made to recede into the background You cant choose

command or operate button when its dimmed

document menu

standard type of submenu displayed by the command just below Info in the main menu

of some applications Its title indicates what you can open and save in the applicationfor

example it might be Document File or Spreadsheet
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dot file

file or folder whose name begins with period and which typically contains

information thÆt you dont need to access Dot files are normally hidden from view in

Workspace Manager folder windows to see them check the UNIX Expert box in

Preferences application

double-click

To click twice in quick succession on the same object double-click extends the kind of

action accomplished by click

drag

To position the cursor on something press and hold down mouse button move the cursor

to new location by moving the mouse and then release the mouse button

EPS

Encapsulated PostScript format for storing graphics

extension

The last period in file name and all characters that follow files extension indicates the

type of information in it The Workspace Manager uses the extension to associate file with

particular application

field

In data document read by WriteNows Merge command each record is made up of

individual fields separated by commas or Tabs each field represents different type of

information See also text field

file

collection of related information stored on disk such as document report letter or

application

file package

special folder containing files that arent normally shown in folder windows Instead

file package looks and behaves like file when you open it by double-clicking for

example To see the files inside file package you must use the Open as Folder command

file system

The collection of all the files you can access through your computer organized so that you
can easily locate the information you want See also hierarchi cal file system

File Viewer

Workspace Manager window that gives you access to all the files in the file system

floppy disk

plastic disk encased in protective cartridge that holds information floppy disk drive

can read or write

floppy disk drive

mechanism that can store and retrieve information from floppy disk

178 Glossary



folder

place in the file system that contains files and other folders Opening folder displays the

names of the files and folders it contains

folder window

Workspace Manager window that displays the contents of one or more folders and that

you use to locate and open files and to organize them for example by moving copying or

renaming them The File Viewer is folder window and you can open folder window

with the Open as Folder command

font

set of properties that describe the appearance of text font family such as Times

typeface for example whether Times Bold or Times Roman and size in points

font family

collection of characters with consistent design for example Helvetica and Times

footer

Text that appears at the bottom of each page of WriteNow document in the footer region

footer region

An area at the bottom of WriteNow page that initially contains the blank default footer

You can ovenide the default footer by defining one or more footers of your own The footer

region is the same height on every page equal to the height of the tallest footer defined in

the document

footnote region

An area just below the body of WriteNow page or column where documents

footnotes if any are displayed

footnote view

The view of WriteNow document that shows only footnotes You can edit footnotes only

in this view

group

class of users for which permissions are assigned to file or folder group is established

by system administrator typically it consists of people working together on the same

project or at common site

hanging indent

First-line indentation to the left of the subsequent lines of paragraph useful for bulleted

or numbered items

hard disk drive

device that can store and retrieve information from metal disks permanently encased

within it hard disk drive is installed inside your NeXT computer

header

Text that appears at the top of each page of WriteNow document in the header region
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header-body separator

In WriteNows Page Layout panel number that should be set greater than or equal to the

height of the tallest line in any paragraph that may cross page boundary If in any such

paragraph you increase the line spacing beyond 24 points or insert text or graphic taller

than 24 points you should probably increase the header-body separator accordingly

header/footer view

The view of WriteNow document that shows only the headers and footers youve defined

in the document You can edit headers and footers only in this view

header region

An area at the top of WriteNow page that initially contains the blank default header You

can override the default header by defining one or more headers of your own The header

region is the same height on every page equal to the height of the tallest header defined in

the document

hierarchicalfile system

file system in which folders can contain other folders down to any number of levels In

hierarchical file system files and folders containing related information can be grouped

into other folders you can open folder to see only the information it contains without

having to view everything on the disk

highlight

To make something such as command text icon or title bar stand out visually

Highlighting usually indicates that something has been chosen to perform an action or

selected to receive an action

home folder

Your home base in the file system the folder that holds your personal files Its name is the

same as your user name me if you dont log in

host name

The name by which computer on network is known to the other computers on the

network The host name is assigned by the system administrator and appears at the top of

the login window

icon

small pictorial representation of an application file folder disk or other item

icon path

An area in the File Viewer that displays icons representing the selected file or folder

initialize

To prepare disk so it can hold information When you initialize disk any information

already on the disk is destroyed You must initialize new disk before you can use it and

you can reinitialize disk to erase its contents

insertion point

The place where text and graphics may be entered usually represented by blinking

vertical bar
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justify

To adjust all the lines of paragraph except the last line so that theyre aligned with both

the left arid the right margins

key window

The standard window or panel that cunently receives keystrokes Its title bar is highlighted

in black You make window the key window by clicking in it

keyboard alternative

combination of keys that you can use instead of the mouse for choosing command You

hold down the Command key while typing the character shown next to the command in the

menu using Shift not Alpha Lock for capital letters

kilobyte

1024 bytes

line spacing

The amount of spacing between lines in WriteNow paragraph It measures the distance

in points from the top of one line to the top of the next line but may be flexible to

accommodate tall text

link

special file that looks and acts like an ordinary file or folder but that accesses the contents

of file or folder thats somewhere else in the file system when you open the link you

actually open this file or folder

log in

To gain access to computer by providing user name and password The login process

restricts the computers use to authorized users

log out

To quit all running applications and if you had to log in to use the computer return to the

login window

mailbox

file package in the Mailboxes folder in your home folder in which the Mail application

stores messages Every user has an Active mailbox where all incoming messages are

delivered

main menu

The menu that appears in your workspace when an application starts up or becomes active

Its title bar displays the applications name or an abbreviation

main window

The standard window that youre currently working in If its not also the key window it

has dark gray title bar and receives any action performed by panel

menu

window that contains vertical list of commands
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merged document

version of the template document created by WriteNows Merge command You can

print all merged documents or ask that all merged documents be copied to single new

document

miniaturize button

control in windows title bar that when clicked reduces the window to miniwindow

__________ mniniwindow

An icon that represents miniaturized window Double-clicking miniwindow returns the

window to the way it was before it was miniaturized

modifier key

key that doesnt generate character but changes the effect of other keys and of actions

taken with the mouse Shift Alternate Command and Control are modifier keys

mouse buttons

The two buttons on the mouse All mouse actions can be performed with either button

unless you specify otherwise in the Preferences application

names record

The record that specifies the names of the fields whose values are stored in the data

document read by WriteNows Merge command

nonbreaking space

space you can type between words so that theyll always be on the same line typed by

holding down the Alternate key and pressing the space bar

open

To put up window in your workspace Opening file or folder puts up window that

displays the contents of.the file or folder

optical disk

plastic disk encased in protective cartridge that holds information that an optical drive

can read or write

optical drive

mechanism that uses laser to store and retrieve information from an optical disk

owner

The person represented by user name who created file or folder class of users for

which permissions are assigned to file or folder

page break character

nonprinting character that forces WriteNow to start new page any text following this

character will begin at the top of the next page The Show Space command from the View

menu displays the page break character as
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page view

The view of WriteNow document in which the document is shown as it will be printed

including page breaks headers footers footnotes and multiple columns Most editing is

done in this view

panel

window that typically appears in response to command and lets you control what the

application does or provides information about the application Panels often perform an

action on standard window

paragraph

In WriteNow text or graphics or both separated by Return or page break characters

password

sequence of characters that you must enter along with your user name when logging in

It can consist of letters numbers symbols and spaces and should be known only to you

pasteboard

The place where the computer stores what you last cut or copied with the Cut or Copy
command

pathname

name or sequence of names separated by slash that specifies file or folder in the

file system See absolute pathname and relative pathname

permissions

Characteristics of file or folder that determine what certain users can do with the file or

folderfor example whether they can view files contents or remove file from folder

Permissions are automatically assigned to file or folder when its created and they can be

changed by its owner

pixel

The smallest unit of measurement on computers screen The NeXT MegaPixel Display

for example measures 1120 by 832 pixels and has approximately 92 pixels per inch

plain ASCII

data format consisting solely of characters from the ASCII character set These include

text characters with no font properties and control characters

point

unit of measurement equal to 1/72 of an inch

press

To position the cursor on something and without moving the mouse hold down mouse

button and keep it down until the desired effect is achieved
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read-only

file that has read permission but not write execute permission for one or more classes

of users is read-only file for those users Read-only files can be read but not written to

record

In data document read by WriteNows Merge command paragraph consisting of field

names names record or field values data record

recycler

An icon always present in the workspace that you use to delete files and folders from the

file system

relative pathname

pathname that starts with name in the current folder and ends with the name of the file

or folder that the pathname identifies

Return key

key used to start new line paragraph or process Its labeled Return on older

keyboards

resize bar

The narrow strip at the bottom of window that you can drag to change the size of the

window

resolution

The number of dots per inch of images on display screen or in printed output The higher

the resolution the clearer the image

root folder

The folder at the top of the file system hierarchy This folder is represented by slash

Its physically located on the startup disk

RTF
Rich Text Format data format that serves as an intermediate step

in the process of

converting from one document type to another

ruler

The numerical scale that displays and lets you change the format of paragraph for

example its indentation and tab stops

save

To store information on computers disk

scroll

To move through information in window or section of window when theres more than

can be displayed at one time so that different part of the information is visible
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scroll button

button that you click or press to scroll by small increments or that you Alternate-click to

scroll by windowful Scroll buttons appear in scrollers and can also stand alone as separate

controls

scroll knob

variable-sized box in scroller that moves as you scroll and that you can drag to scroll

Its length indicates how much of the scrollable contents are cunently displayed and its

position indicates what part of the contents are displayed

scroller

dark gray vertical or horizontal bar containing scroll knob and scroll buttons Scrollers

appear along the left side or bottom of an area that you can scroll through

shell window

window in which you can enter UNIX commands You can open shell window with the

Workspace Managers New Shell command or in the Terminal application

if
Shift key

The key used to produce the capital letters on letter keys and the upper character on keys

labeled with two characters Its labeled Shift on older keyboards

slider

control that lets you set value in range by dragging knob within bar

soft hyphen

hyphen thats visible only when word is split across two lines of text at the point where

the soft hyphen was inserted You can insert soft hyphen with the Insert Soft Hyphen

command in WriteNows Format menu

standard window

window in which you do the primary work of an application standard window is the

usual recipient of actions performed by menus and panels

startup device

The device that provides the system files when the computer is turned on computers

startup device can be its hard disk drive another computer on the network or in rare cases

an optical drive

startup disk

The disk in the startup device that contains the systen files which the computer needs in

order to operate It may be hard disk or an optical disk

subinenu

menu thats opened by command in another menu usually the main menu

Glossary 185



system administrator

The individual in charge of computer network or of computer thats been set up to be

used by more than one person The system administrator registers users and keeps the

network or computer operating properly System administration information is provided in

the Network and System Administration manual

system control keys

Five keys that regulate the computers physical functions the Power brightness and

volume keys

system files

Files which the computer needs in order to operate and which must be loaded into the

computer after its turned on

II1 Tab key

key used to move to the next stopping point in sequence such as tab stop in

document Its labeled Tab on older keyboards

template document

The document into which WriteNow Merge command merges information from some

other source or sources The Merge command takes the document in the key window to be

the template document

text field

control used to enter text white box usually labeled with text that identifies what

information should go in it

TIFF

Tag Image File Format format for storing graphics

title bar

The strip at the top of window that contains its title and possibly buttons for manipulating

the window Its highlighted in black if its the key window or dark gray if its the main

window but not the key window

typeface

variation of font family such as Times Bold Times Italic or Times Bold Italic

user name

The name by which the computer identifies you This is the name you log in with the name

used to identify you as the owner of files and folders and the name of your home folder

Unless system administrator has given you different one your user name is me

volume keys

The two keys that control the volume of the speaker in the MegaPixel Display The upper

key increases the volume the lower key decreases it

window

rectangular area in which information is presented on the screen See standard window
menu and panel
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word

Any sequence of characters between spaces or punctuation marks selected with

doubIec1ick In WriteNow some commands consider hyphen to be one of the

punctuation marks that separate words

word wrap

The automatic breaking of lines between words Word wrap lets you type without having

to press Return to end each line

workspace

The screen environment in which you do your work on NeXT computer

zoom button

button at the lower right of WriteNow document window that enables you to magnify

or reduce the size of the document on the screen
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Addresses command 161 tab stop 20

addresses in Mail 145 Center command 160

aliases in Mail 130 146 Change Case command 39

Align Left command 160 character count in WriteNow 39

Align Right command 160 Check Spelling command

alignment in Mail in Mail 158

tab stop 134 in WriteNow 43

alignment in WriteNow Close command in WriteNow 37

paragraph 21 columns in WriteNow 12

tab stop 20 balancing 55

Allow to Cross Page command 50 multiple 51 54

in multiple-column documents 55 Compact command in Mail 163

alternating compact save in WriteNow 35 37

binding margins 52 Contents command

headers/footers 24 in Digital Quotations 116

arrow buttons in mailbox window 137 in Digital Webster 107

arrow keys in WriteNow 14 conversion

ASCII file See plain ASCII file other types to WriteNow 31 32 169

ASK instruction Merge command 70 WriteNow to other types 35 169

attached files and folders Copy Ruler command

receiving in mail 128 in Mail 160

sending in mail 131 in WriteNow 48

Author button in Digital Quotations 115 copying

font in Mail 160

backup copy in WriteNow 36 footers in WriteNow 25

deletion 36 footnotes in WriteNow 25

binding margins 10 12 headers in WriteNow 25

setting 52 paragraph format in Mail 160

Black command 159 paragraph format in WriteNow 48

body of WriteNow page 11 Copyright command in Digital Librarian 99

bookshelf 85 Count command 39

bookshelf window 86 current document in WriteNow

buttons 91 current message 125

bottom margin See footer region cursor keys See arrow keys

bulleted item in WriteNow 20

Dark Gray command 159

capitalization See case data document Merge command 60 65

case DATA instruction Merge command 66

changing in WriteNow 39 data record Merge command 60 65

in Mail Find 155 date inserting in WriteNow 47

in WriteNow Find 45 decimal tab in WriteNow 20

in WriteNow Spelling 41

Index 189
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header 23 file lock in WriteNow 33 79
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Delete button in mailbox window 138 Find button
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headers in WriteNow 25 Find menu
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Deliver button in Send window 140 in Digital Webster 109
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Edit menu in Mail 159

in Digital Librarian 100
properties during WriteNow editing 15

in Mail 153 substitution in WriteNow 32

in WriteNow 38 Font menu

editing in WriteNow 13 in Mail 159

footers 25 in WriteNow 56

footnotes 25 footer 23
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footnote 26 Hide Ruler command

copying 25 in Mail 160

deleting 25 in WriteNow 46

editing 25 Hide Space command 58

inserting 26 49 hyphen in WriteNow

moving 25 in Find 45

numbering 26 49 52 soft 46

footnote region 11 in spelling check 39
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Librarian See Digital Librarian application footers in WriteNow 25

library See digital library footnotes in WriteNow 25

Light Gray command 159 headers in WriteNow 25

line spacing in WriteNow 22 52 multiple columns in WriteNow 12 54

Lip Service 143

button in Send window 141 names record Merge command 60 65

command 161 New command in WriteNow 33

New Mail
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